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1 Introduction 

The QIAquant 96 Software can be used to create and perform PCR and Real-Time PCR experiments. 

This section describes the basic setup and the layout of the operating elements of the software. 

The short instructions also offer a quick entrance on the operation of QIAquant 96 Software in the 

“Appendix A: Short Instruction“, page 160. 

Described software version 

This description is based on the version QIAquant 96 Software 1.0.3. 

Supported devices 

The program supports the device control and data analysis of the QIAquant 96 devices. 

File formats 

File formats for projects, templates and multi-gene analyses with the extensions QRTP, QRTS, or 

QMGA are used. 

1.1 How to use this user manual 

The following symbols and conventions are used to facilitate orientation in the manual: 

 In the description of the operating procedures, menu commands, dialog boxes, buttons, 

options, etc. are highlighted in bold. 

 Menu commands of a command sequence are separated by “>“, e.g., File > Open 

Project. 
 Buttons are additionally written in bold, e.g., Save. 

1.1.1 Technical assistance 

At QIAGEN® we pride ourselves on the quality and availability of our technical support. Our 

Technical Services Departments are staffed by experienced scientists with extensive practical and 

theoretical expertise in molecular biology and the use of QIAGEN products. If you have any 

questions or experience any difficulties regarding QIAquant 96 Software or QIAGEN products in 

general, do not hesitate to contact us. 
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QIAGEN customers are a major source of information regarding advanced or specialized uses of 

our products. This information is helpful to other scientists as well as to the researchers at QIAGEN. 

We therefore encourage you to contact us if you have any suggestions about product performance 

or new applications and techniques. 

For technical assistance and more information, please see our Technical Support Center at 

support.qiagen.com. 

1.1.2 Policy statement  

It is the policy of QIAGEN to improve products as new techniques and components become 

available. QIAGEN reserves the right to change specifications at any time. 

To produce useful and appropriate documentation, we appreciate your comments on this user 

manual. Please contact QIAGEN Technical Services. 

1.2 Installation of QIAquant 96 Software 

 Administrator rights on the operating system are required for installing the program. 

System requirements for installing QIAquant 96 Software 

Installation procedure 

QIAquant 96 Software is delivered on CD-Rom. 

1. Insert the CD in the CD-ROM drive. Normally, the installation's start window opens 

automatically. 

If this is not the case, start the setup.exe file on the CD. 

A selection dialog window for installing the device driver or the user management or for 

viewing the PDF files of the manuals appears. 

2. Select the device type. 

 Operating system Windows 10  

Processor Min. Intel Core i3, > 1 GHz  

RAM 1 GB 

Available hard disk space Min. 300 MB  

Interfaces Min. USB 2.0 

 

https://www.qiagen.com/support/technical-support
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3. Click on Install. 

The installation routine begins. 

4. Follow the further instructions of the installation program.  

5. Switch on the device at the power switch. Start QIAquant 96 Software. 

Note: The software will only be installed correctly if it has been started once with 

administrator rights. A password for the program administrator must be entered during this 

first start. 

Set up administrator  

After the software installation, an administrator password must be assigned and an administrator 

must be specified. 

1. Start QIAquant 96 Software. 

2. Enter and confirm the password for the administrator in the window LOGIN. 

3. Set up the user profiles (see section “User management”, page 147). 

If the user management is not necessary, disable the user management via Extras > 

Options/Usermanagement. 

 

Update of software 

 

When updating the QIAquant 96 Software from version 1.0.2 to version 1.0.3 or higher, the 

QIAquant 96 Touch Software on your QIAquant 96 instrument also needs to be updated to latest 

software version. For instructions, refer to the QIAquant 96 Touch Software user manual. 

1.3 Starting and exiting QIAquant 96 Software 

Starting QIAquant 96 Software 

1. To start QIAquant 96 Software, click on the Start button on the Windows desktop. Then go to 

the Programs folder and search for QIAquant 96 Software. Click on QIAquant 96 Software 

there. 

2. Alternatively, you may click on the QIAquant 96 Software icon on the Windows desktop. 

QIAquant 96 Software is started. 

You will be then prompted to enter user name and password. The QIAquant 96 Software workspace 

will only become accessible if the entry of this data was successful. 
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Note: An administrator and password must be defined during the first program start. Only the 

administrator can set up further user accounts or disable the user management. 

Exiting QIAquant 96 Software 

1. To exit the QIAquant 96 Software application, activate the File > Exit menu command.  

2. The program will display a message if any projects that have not yet been saved are still 

open at this point.  

3. If you want to save these projects, click on Yes. Save the projects in the Save As standard 

window. 

4. Then call up the File > Exit menu command again to exit QIAquant 96 Software 

1.4 The main window in QIAquant 96 Software 

 

After starting the QIAquant 96 Software the main window opens. It has the following sections: 
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1: Menu bar. The menu bar contains the menu commands for, e.g., opening, editing and saving 

projects, managing user profiles, setting basic software options and a help function. 

2: Toolbar. Commands for editing projects are arranged in the toolbar. The commands offered in 

the toolbar may change according to context. 

3: Project explorer. In the project explorer a drop-down menu provides a quick overview of the 

most important information on the current open project. 

4: Project interface. The project interface is used to process projects. As soon as a new project is 

created or an existing project is loaded, a window opens in which all relevant settings for the 

respective project can be made. 

1.4.1 Menu commands overview 

The menu bar is context-sensitive and is automatically adapted to the program tasks. Menu items 

that are not necessary for the current work interface are automatically hidden. The following menu 

commands are available in the QIAquant 96 Software: 

 Menu Function Description  

 File New Opens a new project  

 New from library Opens the QIAGEN kits template library 

 Open template Opens a template 

 Open project Opens a project 

 Open autom. saved project Opens an automatically saved project 

 Save template Saves a template file in the QIAquant 96 Software standard 
folder 

 

 Save template as Saves a template file in any user-selected folder  

 Save project Saves a project file in the QIAquant 96 Software standard folder  

 Save project as Saves a project file in any user-selected folder  

 Import analyses Opens an analysis file  

 Export analyses Saves an analysis file  

 Import LIMS Imports a transfer file, with which the software of another 
program can be configured, e.g., LIMS 

 

 Multigene Starts the multi gene analysis for analyzing experiments that 
comprise multiple PCR plates and multiple genes 

 

 Close Closes a template or a project  
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 Menu Function Description  

 Close all Closes all open projects or templates  

 Print Prints a project  

 Exit Closes the software  

Edit Undo Reverses the last text modification (up to 10 steps)  

 Redo Restores the last deleted text item (up to 10 steps)  

 Cut Cuts a marked text area  

 Copy Copies an active and/or marked text area  

 Paste Pastes a text area copied to the clipboard  

 Delete Deletes an active and/or marked text area  

 Mark all Marks a complete text area  

 User management Opens the window for creating user profiles and changing the 
password (only available if the user management function is 
activated) 

 

View Project explorer Switches the project explorer view in the main window on or off  

 Toolbar Switches the toolbar view in the main window on or off  

Compliance Show audit trail Display available audit trail  

 Show log file Display available log file  

 Show signatures Display available signatures  

 Sign digitally Create a new digital signature  

Scan Set color compensation Opens the window for creating files for spectral color 
compensation 

 

Extras Device initialization Resets the connected device to the initial state  

 Device identification Activates the connected device  

 Transport lock Prepares the device for transport   

 Options Opens the window for general basic software settings  

Window Tile horz Arranges project windows horizontally  

 Tile vert Arranges project windows vertically  

 Cascade Arranges project windows in a cascaded fashion  

 Info Displays software information  

Cycler Add empty step Adds a new step  

 Delete step Deletes a step  

 Cut step Cuts a step and copies it to the clipboard  

 Copy step Copies the parameters in one step into the clipboard  
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 Menu Function Description  

 Paste step Inserts a copied step  

Scan Edit color compensation Opens the window for creating files for spectral color 
compensation 

 

Samples Edit layout Edit sample table  

 Copy layout Copy the area of the sample table  

 Paste layout Insert the copied area of the sample table  

 Preview layout Detailed view of the plate assignment  

Monitoring Start qPCR run Start the PCR run  

 Stop qPCR run Stop the PCR run  

 Pause qPCR run Pause the PCR run  

 Display options Display options for the product accumulation curves  

 Qbase export Exports measured values as a CSV or an XLS file in qBase format 
(available after Ct calculations) 

 

AbsQuant Add abs. quantification Create new evaluation  

 Delete abs. quantification Delete evaluation  

 Options abs. quantification Opens a window for basic evaluation settings  

 Automa. Threshold Automatic determination of the fluorescence threshold for 
detecting Ct values 

 

 Import standard curve Import a saved standard curve  

 Qbase export Exports measured values as a csv or an XLS file in qBase format  

Relquant Add rel. quantification Create new evaluation  

 Delete rel. quantification Delete evaluation  

 Options rel. quantification Opens a window for basic evaluation settings  

 Automa. threshold/cut off Automatic determination of the fluorescence threshold for 
detecting Ct values 

 

 Import standard curve Import a saved standard curve  

Deltadeltact Add ΔΔct quantification Create new evaluation  

 Delete ΔΔct. quantification Delete evaluation  

 Options ΔΔct. quantification Opens a window for basic evaluation settings  

 Automa. threshold Automatic determination of the fluorescence threshold for 
detecting Ct values 

 

Melting curve Add melting curve Create new evaluation  

 Delete melting curve Delete evaluation  

 Options melting curve Opens a window for basic evaluation settings  
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 Menu Function Description  

 Automa. threshold Determine threshold automatically  

Genotyping Add genotyping  Create new evaluation  

 Delete genotyping Delete evaluation  

 Options genotyping  Opens a window for basic evaluation settings  

 Automa. threshold\cut off Automatic determination of the fluorescence threshold for 
detecting Ct values 

 

Endpoint Add endpoint  Create new evaluation  

 Delete endpoint Delete evaluation  

 Options endpoint  Opens a window for basic evaluation settings  

 Auto threshold\cut off Automatic determination of the cut-off fluorescence value for 
decision POS/NEG 

 

MIQE Import MIQE documentation Imports MIQE information from other project  

 

1.4.2 Overview of the tools in the toolbar 

The buttons in the toolbar are mostly context-sensitive. The program automatically adjusts the toolbar 

to the window content and adds buttons provided that this is re-quired and useful for the current 

project window view. Buttons not accessible for the current contents of the workspace are hidden. 

You can display or hide the toolbar via the View > Toolbar menu command. 

 Button Command Function  

 General    

 

New Opens a new project 

 

Open template Opens a template 

 

Save template Saves a template 

 

Open project Opens a project  

 

Save project  Saves a project  

 

Print project Prints a project  

 

Undo Reverses the last modification  

 

Redo Restores the last deleted modification  
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 Button Command Function  

 

Cut Cuts a marked area  

 

Copy Copies an active and/or marked area  

 

Paste Pastes an area copied into the clipboard  

 

Delete Deletes an active and/or marked area  

 
MultiGene Start the MultiGene- and Multi-Plate-Analysis  

PCR protocol    

 

Add empty step Adds a new step  

 

Delete step Deletes a step  

 

Activate melting curve Adds a step for melting curve determination  

 

Cut step Cuts a step and copies it to the clipboard  

 

Copy step Copies the parameters in one step into the clipboard  

 

Paste step Pastes a copied step  

Color    

 

Edit color compensation Opens the window for creating files for spectral color 
compensation 

 

Samples    

 

Edit layout Assigns changes that were made to the sample table  

 

Copy layout Copies an area in the sample table  

 

Paste layout Pastes a copied area from the sample table  

 

Preview layout Displays a complete view of the plate assignment  

MIQE    

 

Import MIQE Documentation Imports MIQE information from other project  

Monitoring    

 

Start PCR protocol Starts the PCR run  

 

Stop PCR protocol  Ends the PCR run  

 

Pause PCR protocol Breaks the PCR run  

 
 Drive the tray out out of the device  
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 Button Command Function  

 
 Drive the tray into the device  

 

Options Display options of the product accumulation curves  

 

qBase Export Exports measured values as a CSV or an XLS file in qBase 
format 

 

Evaluation/absolute quantification  

 

New Creates a new evaluation  

 

Delete Deletes an evaluation  

 

Options Opens a window for basic evaluation settings  

 

Automatic threshold Automatic determination of the fluorescence threshold value 
for Ct value determination 

 

 

Import standard curve Imports a saved standard curve  

 

qBase Export Exports measured values as a CSV or an XLS file in qBase 
format 

 

Evaluation/relative quantification  

 

New Creates a new evaluation  

 

Delete Deletes an evaluation  

 

Options Opens a window for basic evaluation settings  

 

Automatic threshold Automatic determination of the fluorescence threshold value 
for Ct value determination 

 

 

Import standard curve Imports a saved standard curve  

Evaluation/ΔΔCt analysis   

 

New Creates a new evaluation  

 

Delete Deletes an evaluation  

 

Options Opens a window for basic evaluation settings  

 

Automatic threshold Automatic determination of the fluorescence threshold value 
for Ct value determination 

 

Evaluation/melting curve  

 
New Creates a new evaluation  

 

Delete Deletes the current evaluation  

 

Options Opens a window for basic settings for the evaluation  

 

Automatic threshold Automatically determines the threshold  
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 Button Command Function  

Evaluation/Genotyping   

 

New Creates a new evaluation  

 
Delete Deletes the current evaluation  

 

Options Opens a window for basic settings for the evaluation  

 
Auto threshold/cut off Automatically determines the threshold  

Evaluation/Endpoint    

 
New Creates a new evaluation  

 Delete Deletes the current evaluation  

 

Options Opens a window for basic settings for the evaluation  

 Auto threshold/Cut off Automatic determination of the cut-off fluorescence value for 
decision POS/NEG 

 

 

1.4.3 Project explorer components 

Different menus (2) in the project explorer offer a quick overview of the currently processed project. 

Individual projects can be selected via a selection list (1). The information on the individual menus 

can be displayed or hidden via the + and – (3) buttons. 
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Organization of the project explorer 

 Menu Information  

General Project title, user, start, end and device 

Thermocycler Graphic display of the history of the PCR program in the active project 

Scan Overview of the colors and areas of the PCR plate that are being scanned 

Samples Displays a short info text on the plate layout.  

Used for activation or deactivation of samples during measurement and evaluation 

(see sections “Display options for monitoring“, page 62 and 

“Activating/deactivating samples for evaluation“, page 75). 

The edit mode for the plate layout displays detailed information on the selected well. 

Absolute quantification Graphic display Ct against log concentration  

Relative quantification Graphic display Ct against log concentration  

ΔΔCt Graphical display dCt(V) compared to log concentration  

Melting Curve Graphical display of melting curve compared to temperature  

GenoTyping Graphical display of dRn Genotype 1 compared to dRn Genotype 2 as a scatter plot or 
bar graph 

 

Endpoint Graphical display of endpoint fluorescences as a bar chart for the GOI and the IPC  
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You can display or hide the project explorer via the View > Project explorer menu command. 

1.4.4 Project interface with project window 

The project window opens when a new project is created or a saved project and/or a template is 

loaded. The QIAquant 96 Software comes with standard QIAGEN real-time PCR kits templates pre-

installed for convenience. 

  

In the project window all parameters, measuring data and evaluations for one PCR plate are 

combined. The basic functions are arranged on the four main tabs on the top: 

 Tab Function  

Settings Contains all functions required for defining Real-Time PCR runs 

Monitoring Contains different tools for monitoring Real-Time PCR runs 

Analysis Includes the evaluation algorithms implemented in the software for analyzing acquired 
data 

Documentation Opens the input mask for MIQE compliant documentation of Real-Time PCR experiments  
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These 4 tabs are always visible. The view of the project window changes depending on the selection 

of a function tab. To indicate the tab the descriptions refer to, the tabs and list sheets are listed in 

the order in which they were activated and divided by a slash, e.g., Settings/Thermocycler/Table. 

1.4.5 Version number of the software 

By means of the Help > Info menu command, you open the window with information on the version 

number of the software program. 

1.5 Warranty and liability 

The warranty and liability periods comply with the legal requirements and the provisions in the 

General Terms and Conditions of QIAGEN.  

Deviations from the intended use described in this manual result in limitations of warranty and 

liability in the event of damage.  

Warranty and liability claims are excluded for personal injury and property damage due to one or 

several of the following causes:  

 Use of the QIAquant 96 Software other than intended  

 Improper commissioning, operation and servicing of the device 

 Modifications of the equipment without prior consultation with QIAGEN 

 Unauthorized intervention in the equipment 

 Operation of the device with faulty safety equipment  

 Use of other than original spare parts, wearing parts or consumables  

 Improper repairs 

 Improper transport and storage of the device 

 Faults due to the nonobservance of this manual 
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2 Managing projects and templates 

The QIAquant 96 Software saves all experiments in the project files. A project contains different 

information required to perform a Real-Time PCR experiment: 

 Description of the experiment 

 PCR protocol 

 Scan settings of the optical system 

 Plate assignment with detailed information on each sample 

 Measuring results and the corresponding evaluation after the experiment has been performed  

All basic information required for performing an experiment that is stored in the project window on 

the Settings tab, such as the description of the experiment, the PCR protocol, scan settings of the 

optical system and the plate assignment, can be saved as a template.  

Following file extensions are used in the software: 

When saving, you can select in which format the files are to be saved.  

2.1 Creating a new project or opening a project 

A project is always indicated in a project window in a section of the project interface of the main 

window.  

Creating a new project 

To create a new project, click on  or call up the File > New menu command.  

A new project with standard presets is created in the project window. 

 Extension  File type  

QRTP  Real time project file 

QRTS  Real time settings file 

QMGA  Real time multigen analysis file  

QTRF  LIMS transfer file  

QRTA  Real time analysis file  
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Creating a new project based on a template 

A new project can be opened with saved presets (template):  

1. Click on  or call up the File > Open template menu command.  

2. In the standard window, select the desired template to open files and confirm the selection 

with OK. 

A new project with the parameter settings of the template is created in the project window. 

Opening a saved project 

1. Click on  or call up the File > Open project menu command.  

2. In the standard window, select the desired project to open files and confirm the selection with 

OK. 

The project with the parameter settings, measurement results and evaluations is created in the 

project window. 

Opening an automatically saved project 

The QIAquant 96 Software programs enables you to automatically save the last completed Real-

Time PCR run to a folder of your choice and thus prevents data loss due to unexpected terminations 

of a PCR run.  

1. Recover the terminated measurement with the File > Open Autom. Saved Project menu 

command. 

2. Save the file under a different name as a project file. 

To change the storage location of the file, proceed as follows: 

1. Select Extras > Options To open the window of the same name. 

2. Open the General tab. 

3. Click … and select a storage location. 

Viewing the projects 

You can open several projects at a time. Each project is displayed in its own project window. With 

the commands from the WINDOW menu, the project windows can be arranged: 
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Changes can only be made in the respective active window. 

2.2 Saving a template 

All basic information required for performing an experiment that is stored in the project window on 

the Settings tab, such as the description of the experiment, the PCR protocol, scan settings of the 

optical system and the plate assignment, can be saved as a template.  

1. Call up the File > Save template as command. 

2. To save files enter the name of the template in the standard window and save the template 

with OK. 

The changes in a template can be saved with the File > Save template menu command. Optionally, 

you can click on the  symbol in the toolbar. 

2.3 Saving a project 

You can save the project with all parameters of the PCR run, the fluorescence curves and 

evaluations. 

1. Call up the File > Save project as command. 

2. To save files enter the name of the template in the standard window and save the template 

with OK. 

The changes in a project can be saved with the File > Save project menu command. Optionally, 

you can click on the  symbol in the toolbar. 

In the window Options/General (menu command Extras > Options) you can define the default 

folder in which the file will be saved. The results of the PCR run are automatically saved 

without user interaction. The file name consists of the date or the selected name and a three-

digit index. 

 Command Description  

Tile horz In the horizontal layout the project windows are shown below each other. Dependent 
on their number they are additionally arranged in two columns next to each other for 
more than 4 project windows. 

Tile vert In the vertical layout the project windows are shown next to each other. For more than 4 
project windows they are additionally divided into two columns. 

Cascade In the cascading layout the project windows are placed on top of each other with an 
offset. 
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2.4 Importing/exporting analyses 

Settings for the data evaluations of a project can be saved (exported) and later transferred 

(imported) to an open project. The evaluations are applied to the open project when they are 

imported. 

1. Select the File > Export analyses menu command. 

2. To save files enter the name of the analysis and save the files with OK. 

Analyses are saved with the extension QRTA. 

1. Select the File > Import analyses  menu command. 

2. Select the name of the analysis in the default window for opening files and import the 

analysis into the current project by clicking OK. 

2.5 Creating a project template from a transfer file 

With the File > Import LIMS menu command, a project template is created from a transfer file and 

a PCR run can be started (see section “Appendix C: Creating a Project Template from the Transfer 

File (LIMS)”, page 169). 

2.6 Performing a Multigene-/Multiplate-Analysis 

The File > Multigene menu command  allows the analysis of experiments that required multiple PCR 

runs and that comprise multiple genes (see section “Multigene-/Multiplate-Analysis”, page 130). 

2.7 Closing project windows 

The File > Close menu command closes the active project window. To close all project windows, 

select the File > Close all menu command. If any unsaved changes have been made in project 

windows, a confirmation prompt appears. 

2.8 Printing 

You can specify the desired contents for printing a project in a selection list: 
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1. Select the File > Print menu command. 

2. Manage the print output using the displayed lists. Select the desired information in the list on 

the left and click  to transfer it to the print list on the right. To remove undesired 

information from the print list, click . 

3. Click Print to start the printout. 

4. Select Options to configure the printout, or Preview to display a page view of the print 

image. 

The individual print modules are sorted into the Settings, Monitoring and Analysis subgroups in the 

Print window. 
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3 Settings for a Real-Time PCR experiment 

If you want to start a new project, create a new project or open a template: 

 Create an empty project with a click on  in the toolbar. 

 Optionally, open a template with  to use the previously stored parameters for the new 

project or to modify them. 

All functions necessary to create a new project are combined under the SETTINGS tab. Additional 

tabs on the second level are assigned to the Settings tab: 

3.1 Entering general information on the project 

You can save general information on each project. The entries can be made on the General tab: 

  

 Tab page Function  

General Allows you to enter general information and remarks 

Thermocycler Used for programming PCR protocols 

Scan Definition of the colors to be measured and settings for the measuring parameters 

Samples Opens the sample table in which detailed information on each sample can be saved and 
groups of experiments defined 
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Note: For text inputs on the tab General being able to use the usual commands for copying, cut out 

and insert of texts. These commands are arranged in the menu EDIT.  

3.2 Creating a PCR protocol 

A PCR protocol must be programmed for each Real-Time PCR experiment. All necessary functions 

are combined in the Settings/Thermocycler project window. The screen is divided in three sections: 

graphical program preview (1), program header (2) and program table (3).  

 

 Command Description  

Title Analysis title 

Operator User 

If you are using a user management option, the user name you signed in with will be 
entered automatically. 

Start/End Date and time the project started and ended 

Comment Comment input 
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The program preview illustrates the history of the PCR protocol. The program header defines the 

general conditions for the PCR protocol, such as the programmed lid temperature and the lid-heating 

mode. The programming table offers a clear representation of the individual steps of the program. 

The Thermocycler tab contains three list sheets. The tabs for switching between the list sheets are 

located at the bottom of the window. 

Editing a PCR protocol 

Programs can be edited in the tabular or graphical representation. 

You can switch between the two alternative representations via the Table and Graph screens. To 

edit one step (the current active step is highlighted light red) you can use the corresponding function 

from the Cycler menu in the menu bar or the corresponding symbol from the toolbar: 

 

 List sheet Function  

Table Contains a table for programming PCR programs. 

Graph Offers the option for graphical programming of PCR programs. 

Melting curve Is used to enter parameters for measuring a melting curve. 

Gradient Enables set up of PCR programs using the gradient function  

 

 Symbol (Cycler/...) menu command Description  

 

Add empty step Inserts a new step behind the active step 

 

Delete step Deletes the active step 

 

Cut step Cuts the active step 

 

Copy step Copies the active step 

 

Paste step Inserts a copied step behind the active step  
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3.2.1  Entering information in the program header 

The program header contains several general, device specific program settings: 

 

 Options for lid heating 

 Temperature control method 

 Stand-by mode activation after the PCR is complete 

  

3.2.2 Overview about the PCR protocol 

The PCR program is entered into the program table of the Table list sheet. One row of the table 

contains the parameters of a temperature step.  

 Option/List Description  

Lid temp. Sets the lid temperature. 

The temperature of the heating lid should generally be slightly above the maximum block 
temperature to prevent liquids from evaporating from the reaction mixture and condensing at 
the walls or lid of the reaction cups.  

Preheat lid If activated, this option preheats the lid to the set Lid temperature before the actual PCR 

program starts. 

This is the recommended standard setting to ensure the formation of a homogeneously 

tempered air cushion between the sample containers. This leads to an improved temperature 

uniformity between the samples. While the lid is being heated, the block is kept at a 

constant 25°C. 

If the option is deactivated, the PCR program starts while the lid is still being heated.  

Adjustable lid temperature: 30 – 110 °C 

Note: After the heating lid has reached the target temperature, this is followed by a 40-
second equilibration before the program is started. 
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You can navigate in the program table by using the mouse or the four arrow keys     on 

the keyboard. Each entry is confirmed with the Enter key or the  arrow key. The cursor jumps into 

the corresponding field in the adjoining column. If the cursor is in the last row, an additional 

temperature step is inserted with . Click in the next empty row for inserting an additional 

temperature step. 

The following values are entered into the table or calculated from the default values: 

3.2.3 Inserting a new temperature step/deleting a temperature step 

You can insert an additional temperature step to the program table with one of following functions: 

 Set the cursor in the last row of the temperature program and press the  arrow key. 

 Select the menu command Cycler > Add empty step. 

 Click on . 

 Click with the mouse on the next row under the program. 

The total number of steps and the current processed step are displayed in the protocol header. 

 Value Description  

Scan Measures the sample fluorescence during this step, if marked 

Steps Number of the step in the temperature program 

Is automatically numbered consecutively 

°C Enter the target temperature of the step in °C 

m:s Enter the hold time of the target temperature 

GOTO/LOOP Define the loop with the number of repetitions for a cycle  

ΔT(°C) Enter the increment or decrement of the target temperature within the PCR run  

Δt(s) Enter the increment or decrement of the hold time within the PCR run  

(°C/s) Enter the heating or cooling rate to reach the target temperature in the temperature step  
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 To delete a program step move the cursor to the program row and click on . 

Optionally, select the Cycler > Delete step menu command. 

3.2.4 Entering the target temperature, hold time and heating/cooling rates 

 Enter the target temperature of the temperature step into the °C column. 

 Into the m:s column, enter the hold time in the format “minutes:seconds” (e.g., hold time of a 

duration of 1 min 20 s: 1:20). 

 For special applications or the transfer of protocols from other devices it may be required to 

adjust the heating and cooling rates.  

Enter the average heating and cooling rate for each individual step in the (°C/s) column.  

Note: The value in the (°C/s) column defines the speed at which the target temperature is 

reached. If the temperature is be heated (or cooled) at a speed of 3°C per second between 

step 2 and step 3 the value 3.0 must be entered for step 3. 

Note: If the speed is to be reduced for the whole program the heating or cooling rates of all 

steps must be adjusted. The settings are only valid for that one program. 

 

3.2.5 Defining loops 

Program sequences that are repeated regularly can be summarized in loops. Generally, a loop is 

then defined by a target step for the return (goto and the number or repetitions (loops).  

 

1. Place the cursor on the last step of the future loop (step 4 in the example above). 
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2. Enter the number of the target step into the goto column (“2” in the example above). 

3. In the loops column enter the number of repetitions (“39” in the example above).  

After entering the target step and the repetitions the programmed loop is displayed as a bracket on 

the left side of the table. 

Note: The total number of loops displayed in the bracket is determined from the number of 

programmed repetitions plus 1, as the corresponding sequence of steps prior to reaching the loop 

has already cycled once. 

3.2.6 Entering increments/decrements for temperature and hold time 

By programming increments/decrements the temperature or hold time can be modified by a specific 

amount from one cycle to the other within a loop. This technology is for instance used for the “Touch 

Down” PCR. 

 

 Enter the desired changes for the temperature step the values of which you wish to modify 

within the loop. Use the – sign to specify a decrement, i.e., temperature or hold time are 

reduced from cycle to cycle by the specified amount. No sign or + mark a decrement with the 

result that the parameter increases by the specified amount from cycle to cycle. 

 To modify the target temperature in steps, enter the changes in the ΔT(°C) column. 

 To modify the hold temperature in steps, enter the changes in the ΔT(S) column. 

Note: The modified step must be within a loop. Otherwise, the entries in the columns ΔT(°C) and 

ΔT(S) have no effect. 

Note: The extension of the hold time of one step affects the total run time of a protocol. A program 

with many cycles and significant hold time increases takes substantially longer than a comparable 

program without a programmed extension. 
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3.2.7 Arranging a fluorescence measurement 

 To define the measurement of the sample fluorescence in a temperature step of the PCR 

protocol, click on the Scan column of the temperature step. A green diamond () indicates 

that the measurements is active.  

  

Define the parameters for the fluorescence measurement on the Scan tab (see page 36). 

Note: If a step for melting curve determination is added, the scanning process is automatically 

activated for this step. For all other steps of the PCR protocol the allocation must be made manually.  

3.2.8 Adding a melting curve 

For experiments with intercalating dyes we recommend checking the specificity of the products by 

measuring a melting curve. The device can be programmed to add the corresponding step in the 

PCR protocol. Activate the option active on the Melting curve tab. 

 

 A melting curve can be added to the program table by activating the option active on Melting 

curve tab. 

The melting curve is added to the last temperature step in the table.  

 To remove a melting curve from the program table, deactivate the option active on melting 

curve tab. 
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 Set the individual parameters of the melting curve step on the Melting curve tab: 

 

The following parameters can be modified: 

The fluorescence measurement is automatically defined when the melting curve is recorded. 

3.2.9 Programming the temperature gradient  

Gradients can be programmed over the whole temperature range of the thermoblock between 3°C 

and 99°C. The gradient range can be max. 40°C. 

Temperature gradient with margin rows 

 Gradients are defined in the program table by entering two temperature values separated by 

a dash. The first value entered corresponds to the temperature in column 01 (left block side), 

the second value to the temperature in column 12 (right block side). 

 Parameter Description  

Start temp. (°C) Start temperature of the melting curve 

End temp. (°C) End temperature of the melting curve 

Equilibration (S) Time for equilibration of the sample in a temperature before a measurement is performed  

Increment ΔT Difference between two adjoining temperature steps in °C 

Heating rate (°C/S) Heating rate of the block  

Active Add a melting curve on the end of the PCR protocol.  
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The progression of the temperature gradient can be reviewed on the Gradient tab. The temperatures 

in the individual columns of the block are summarized in a table below the bar graph. 

 

 Adjust the gradient progression by entering temperature values for the first (Temp. row 01) 

and last (Temp. row 12) column of the block. 

The values displayed in the table are then updated.  

 Alternatively, you can click on the top end of column 1 or column 12 and change the height 

of the column with the left mouse button depressed. Moving the columns changes the 

respective temperature value accordingly. 

  

Programming a linear gradient 

In addition to the option of defining a gradient by entering temperature values for columns 1 and 

12, the gradient can also be programmed starting with an annealing temperature in the center of 

the block using fixed temperature increments.  

 On the Gradient tab, select the Linear option from the View list. 

 Enter the temperature for column 6 in the Annealing temp. field and the desired temperature 

change from column to column in the Increment field. 

 The values displayed in the table are updated after the values have been entered.  
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 Another option for adjusting the gradient is to click on the top end of column 6 and change 

the height of the column with the left mouse button depressed. Moving the column the changes 

the annealing temperature accordingly. 

  

3.2.10 Graphical display and programming the PCR protocols 

In the Settings/Thermocycler project window, the history of a programmed PCR protocol is 

displayed graphically in the Table and Graph screens. It represents the temperature curve of the 

block (blue line) and the heating lid (red line) over time. The green diamond symbolizes steps during 

which the fluorescence is measured. 

  

Programs are generally created in the table view, which allows new steps to be programmed quickly 

and provides a summarized overall survey of the protocol structure. Some programming options 

are only available in the table view. The graphical programming mode additionally offers a 

schematic representation of the temperature profile and the option to adjust protocols quickly. In 

the Settings/Thermocycler project window you can switch between the table view and the graphical 

mode via the Table or Graph sheets. 
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The graphical programming is generally performed in the same way as in the programming table. 

 By selecting a step (clicking on it) it becomes active and is highlighted light red.  

 The bottom part of the display shows the number of the corresponding protocol step.  

Next to it, the number of repetitions in loops (right) and scanning processes (middle) can be 

programmed in this field.  

The number of repetitions is indicated as a figure (e.g., 40x ) and can be edited by clicking 

on it with the left mouse button.  

Planned measurements are displayed by means of a green diamond in the middle of the field 

and can also be selected or deselected with the left mouse button. 

 Temperatures and hold times are indicated as numerical values above or below the blue line 

that displays the corresponding temperature level at the individual steps. The values can be 

modified by clicking with the left mouse button. Melting curve steps are marked with the 

addition Melt. Additionally, a symbol of an arrow pointing upwards is displayed with the 

melting curve steps (). 

Note: The number of repetitions in melting curve steps cannot be modified. 

 The temperature value at each step can be modified using the mouse. For this purpose, press 

and hold the left mouse button to move the blue line of the temperature curve up or down.  

3.3 Defining the parameters for the fluorescence measurement 

The product accumulation is measured by means of the increase in fluorescence in the Real-Time 

PCR. The following measurement parameters must be defined for that purpose: 

 Dyes to be measured 
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 Temperature step of the PCR protocol during which a measurement is to take place 

 The area on the PCR plate that is to be scanned  

The colors to be measured are defined in the Settings/Scan project window: 

 

Up to 5 color channels with different excitation and detection wavelengths can be used for the 

fluorescence measurement. The parameters of the fluorescence measurement apply for all layout 

samples on which a measurement is to be performed. 

The excitation and detection wavelength information is only displayed in the scan menu when the 

QIAquant 96 instrument is connected to the computer and switched on. 
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The Scan tab contains a table with different parameters for defining the scan properties: 

Following lists and options are available on Scan tab: 

Set the following parameters for each channel you wish to make a measurement for: 

1. Select the dye to be measured in the Dye column. Click in the cell and mark the dye in the list 

that opens up. 

Note: The number of measured dyes does not have an influence on the scan time. 

2. Set the signal quality in the Gain column.  

The standard setting is 5. 

3. Activate the fluorescence measurement in the channel in the Measurement column by placing 

a green diamond (). 

Channels that are not marked with a diamond will not be measured. 

 Table parameters Description  

Pos. Color module position in the device 

Channel Color channel description 

Excitation/Detection Excitation and detection wavelength of the color channel 

Dye Define the dye to be measured for the corresponding channel in the table by means of a 
selection list 

Gain Regulation of signal intensity 

The signal intensity can be adjusted in steps between 0 and 10. The higher the value, the 
higher the fluorescence signal in the corresponding channel.  

Standard value: 5 

 

Measurement Activates dye measurement 

An active measurement is indicated with a green diamond () 

 

Pass. ref. The LED technology of the device does not require a passive reference. If you wish to measure 
a reference dye anyway, place a checkmark in this column. 

 

 

 Option Description  

Meas. repeats Enter the number of repetitions of the fluorescence measurement  

Possible values: 1 to 16 ;  Standard value: 3 

Color compensation Activate spectral compensation (see section “Color compensation”, page 39). 

Scan region 
according layout 

Sample measurement according to the layout of the samples on the Sample stab (see section 
“Editing the sample table”, page 42). 

Define scan region 
manually 

Sample measurement according to manual settings (see section “Manually defining the scan 
region”, page 38). 
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4. If necessary, activate the reference dye measurement by placing a check mark () in the 

Pass. ref. column. 

5. Enter the number of repetitions for the fluorescence measurements in the Meas. repeats field 

(Standard setting: 3). 

Note: An increased number of repeat measurements reduces the measurement value 

distribution but also creates longer scanning times and thus longer protocolling times. 

6. Select one of the options for the Scan region (manually or according to layout). 

3.3.1 Manually defining the scan region 

The scan region can be defined according to the plate layout in the sample table (see section 

“Editing the sample table”, page 42) or manually. The scan region for the thermocycler is always 

defined per column. It must always consist of connected columns. 

1. For a manual sample selection, select the Define scan region manually option on the 

Settings/Scan tab. 

2. A graphical representation of the sample block is opened. 

3. Enter the first and last column of the region to be scanned into the From column and To 

column fields. 

Optionally, you can use the mouse to select the columns. To select an individual column, click 

directly into that column. If you wish to select several columns, press and hold the left mouse 

button and move the cursor over the corresponding area. 

Active columns are highlighted blue in the diagram. 
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3.3.2 Color compensation 

If you are using several dyes per reaction mixture, the result may be a fluorescence crosstalk. This 

means that a second dye is excited and measured next to the desired dye at the same time. To 

subtract the fluorescence quotient of the second dye, you can use the color compensation function 

on the Settings/Scan project tab.  

QIAquant 96 Software offers two different variants for color compensation on measurement data: 

 Using the standard color compensation Standard 

 Recording and selection of a customer-specific color compensation 

Color compensation: Off 

The standard setting for the color compensation is Off. This is due to the fact that color compensation 

is not required for all applications (only one active measuring channel or dyes that are spectrally 

widely spaced, such as FAM and ROX). 

Color compensation: Standard 

Using the standard color compensation, a compensation matrix is applied to the measurement data 

which permits a sufficient compensation of the crosstalk in all colors in the case of the gain setting 5. 

Select Standard from the Color compensation list for using the standard color compensation. 

Color compensation: Selection 

A different color compensation can be selected, for instance using a compensating matrix recorded 

with the used dyes (see “Spectral calibration” below). 

Select Select from the Color compensation list for using this color compensation. A window appears, 

in which color compensations that have already been recorded can be opened and used again. In 

the window only those compensation data are printed in black color which meet the settings on the 

card Scan. Invalid compensation data appear in red color and cannot be selected. 
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Select a color compensation for the current project with the left mouse button and press OK to 

activate that compensation. 
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Spectral calibration 

With the  symbol or the menu command Scan > Edit color compensation, you can create a new 

color compensation by measurement. This process is called spectral calibration. A new window 

opens, in which all the required settings can be made. The window is divided in a selection list for 

dyes and a plate diagram. 

 

 

To record the calibration data the dyes required for a color compensation must be available 

individually in solution. You could for example use the sensors for the calibration measurement that 

are to be used in the later PCR experiment. The dye concentration for the calibration measurement 

should be approx. 0.1 µmol/l. 

In the displayed plate diagram the wells that contain the calibration samples are now marked 

individually for each dye and the dye in each of the samples is assigned to the marked well by 

clicking on the blue arrow. The dyes offered for selection are those that were selected in the 

Settings/Scan project tab. 

For an exact calibration measurement we recommend that each dye be created at least as a triple 

replicate. In addition, the temperature at which the calibration measurement should be performed 

can be set. This should be the same temperature at which the fluorescence measurements are 

performed during the PCR run.  

The calibration measurement is started by clicking on  Start measurement. 
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Note: The selection of available dyes cannot be modified in this table. Modifications can only be 

made on Scan tab. 

The new color compensation needs to be assigned a description in the name field. It is included in 

the selection list after pressing OK and will be displayed in the corresponding window. Templates 

that are no longer in use can be deleted with Delete. 

3.4 Editing the sample table 

The sample table defines which sample is in which position of the block. These details are required 

for using the evaluation functions of QIAquant 96 Software. Here, a sample can be described by 

means of its properties, such as name, gene, type, concentration and dye. Furthermore, samples 

from different experimental approaches can be combined in groups.  

The necessary entries can be made on the Samples tab after pressing the Edit layout button. The 

corresponding window is divided into different sections: 
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Note: The sample table can also be edited after the Real-Time PCR run has been completed. 

 Range Function  

1: Layout view Graphical display of the well assignment on the microplate 

3: Edit area Edit area for the sample properties: 
 Sample name 
 Sample type 
 Concentration of standard samples 

Allocation of the dye and the analyzed gene 

2: Sample table Summary of the information on each sample  

4: Dyes Dyes and assigned genes for each sample 
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3.4.1 Entering sample properties in the layout 

You can define the properties for the samples in the wells on the Settings/Samples project tab in 

the layout view and the edit area next to it. 
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Note: The color code of the inner circle that defines the different sample types and the color code 

of the outer ring that defines replicates can be modified in menu Extras > Options > Colors. 

The following sample types can be defined: 

Samples with identical sample properties (sample name, sample type, same gene-dye-assignments) 

are viewed as replicates. For a better overview replicates are indicated by the same color code of 

the outer ring. The individual values of these samples are averaged and their mean value is used 

for the remaining calculations. 

With a singleplex assay, samples can have the same sample name and sample type but differ as 

far as the gene-dye-assignment is concerned. These samples are identified as associated samples 

due to the same name. The evaluation, however, is performed individually. 

 Sample type Symbol Definition  

Empty  Describes an empty position on the PCR plate 

Unknown U Sample of unknown concentration or dilution (measuring sample) 

Standard S Sample of known concentration or dilution 

Calibrator K Sample the target gene expression level of which is set to 1 

No template control (NTC) N Complete reaction mixture but without template strand  

Positive control + Positive control assay for which a reaction product can be expected  

Negative control – Negative control assay for which no reaction product is to be expected  
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 Mark the sample position to be edited by clicking into the layout. To select adjacent positions 

press the left mouse button and define an area. To select nonadjacent positions press the Ctrl 

key on the keyboard plus the left mouse button at each position. 

To mark rows or columns, click on the corresponding row or column name A–H or 1–12. 

You can mark all sample positions in the layout by clicking on the gray button in the top left of 

the layout (between 1 and A). 

  

 Enter the following sample parameters in the adjacent edit area: 

 You can assign sample properties to the marked positions by clicking on  or by pressing 

Enter. 

For emptying on ore more wells, press the DEL key. 

Note: The entries for the selected area will only be applied by the program after they have 

been assigned. Entries or modifications that are not assigned will be lost. 

 To display defined sample properties in the edit area, double-click on a well. 

 You can edit the information and assign them to the well again by clicking  or by pressing 

Enter. 

To assign these sample properties to other wells, mark the desired wells and then click  or 

press Enter. 

 By using the context menu it is possible to assign gene names to the selected wells afterwards 

without changing the other properties which had already been assigned. The context menu 

can also be used to assign and to remove sample wells which do not contain an internal 

positive control (IPC-). The context menu is displayed by right clicking the PCR plate scheme. 

 Parameter Description  

Sample name Sample description 

Sample type Selection of the sample type (see top of table)  

Target table  

Gene column In the dye row, enter the gene to be analyzed 

Conc. column For standards 

Enter the concentration of the gene to be analyzed. 
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The entry of a sample layout is described by means of an example for a singleplex assay and a 

multiplex assay (see sections “Entering a sample layout for a singleplex assay”, page 51, and 

“Entering a sample layout for a multiplex assay”, page 49). 

3.4.2 Entering sample properties into the sample table 

You can also make entries in the sample table itself. 

 Select the desired position in the layout view or a field directly in the sample table.  

The corresponding row is then highlighted yellow.  

 Enter descriptions and/or values directly in the designated cells.  

The sample table is edited cell by cell. Multiple selections and the associated assignment of 

parameters to several cells or rows at a time are not possible. 

 

The genes and, in the case of standard samples, their concentration are summarized separately by 

dye in the second part of the sample table. A list sheet is assigned to each dye. It is thus possible 

to use different standard concentrations for each gene. The number of displayed sheets depends 

on which dyes have been activated on the Settings/Scan project tab for this measurement. 

 Enter for each gene the desired standard concentration. 
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Selecting the table view 

Depending on the selected window size and the number of dyes to be measured, two buttons with 

left and right arrows appear. They can be used to move between the different tabs. 

The number of columns that are displayed in the sample table can be user-defined: 

 Right-click on a column header to display and mark the desired columns in the context menu.  

 The order of the columns can be changed by clicking on the table header and dragging with 

the mouse. 

 

Selecting curve colors 

Note: The general color settings can be made in the Options/Color window (Extras > Options menu 

command). This is where the colors for wells, replicates, and sample types are determined. 

In the graphic representation, the amplification curve is highlighted in the color shown in the second 

column of the sample table. You can change the color individually: 

 Double-click on the color cell to be changed in the sample table and select the desired color in 

the Color window. 

 In order to reset the color of a well, press the Shift key and double-click on the color cell at the 

same time. The color is reset to the default setting in the Options/Color window. 

 To allocate the same color to multiple wells, press the Ctrl key and double-click on the color 

cell of a well. 

 Mark the applicable wells in the plate layout in the Edit colors window and select the shared 

color. Click Accept to assign the color to the wells. Click Reset to reset the color changes in the 

marked wells to the default settings in the Options/Color window. 

Displaying sample properties in the project explorer 

Moving the mouse pointer over a well on the Sample project tab in the layout view will display the 

properties of the well in the Samples menu item in the project explorer. 
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3.4.3 Entering a sample layout for a multiplex assay 

The following example shows the definition of four samples and standards with three repeat 

measurements each in the layout. The GAPDH gene is analyzed with the FAM dye and the c-myc 

gene with the VIC dye. The two dyes are selected on the Settings/Scan project tab and activated 

for measurement. The indicated sample names and standard concentrations serve as examples 

only. 

1. Activate the Edit layout button. 

Emptying sample layout 

2. Empty the plate layout to make sure that no unintentional entries remain: 

 Mark the complete plate by clicking on the gray button in the top left of the layout. 

 In the Sample type list select the option Empty. 

 Click on  or press Enter. 

Defining samples 

3. Mark the 3 wells A1–A3. 

4. Make the following settings: 

Note: The genes are allocated to the corresponding dye by entering the name of the gene or by 

selecting it from the displayed list in the Target table. 

5. Click on  or press Enter, to assign the sample properties to the three wells. 

6. Repeat steps 3–5 for the other samples.  

 Parameter Entered value  
Sample name Sample 1 

Sample type Unknown 

FAM GAPDH 

VIC C-myc 
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Use the following parameters: 

Defining the standard samples 

7. Mark the three wells C1–C3. 

8. Make the following settings: 

9. Make the following entries in the Target table: 

Note: The Conc. column in the Target table is only available for the Standard sample type. 

10. From the Unit list, choose a concentration or mass unit. You can select from the following 

units:  

 ng 

 ng/µl 

 ng/ml 

 pg/µl 

 copies 

 copies/µl 

 copies/ml 

 mg/ml 

 IU/µl 

 IU/ml 

 %  

11. Click on  or press Enter, to assign the sample properties to the 3 wells. 

 Wells Sample name Sample type FAM VIC  

A4–A6 Sample 2 Unknown GAPDH c-myc 

B1–B3 Sample 3 Unknown GAPDH c-myc 

B4–B6 Sample 4 Unknown GAPDH c-myc 

 

 Parameter Entered value  

Sample name Std 1 

Sample type Standard 

 

 Dye Gene Conc.  

FAM GAPDH 100 

VIC c-myc 50 
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12. Repeat steps 7–10 for the other 3 standards. Use the following parameters: 

   Conc.   

Wells Sample name FAM VIC 

C4–C6 Std 2 50 5 

D1–D3  Std 3 10 1 

D4–D6  Std 4 0.1 0.05 

 
 As sample type, select the Standard option. 

 Assign the genes to the dyes as described in step 6. 

 The plate layout for a multiplex assay is complete. 

3.4.4 Entering a sample layout for a singleplex assay 

The following example shows the definition of four samples and four standards with three repeat 

measurements each in the layout. The GAPDH and c-myc genes are analyzed with the FAM dye 

with the help of two sensors. The FAM dye was selected on the Settings/Scan project tab and 

activated for the measurement. The indicated sample names and standard concentrations serve as 

examples only. 

1. Activate the Edit layout button. 

Emptying sample layout 

2. Empty the plate layout to make sure that no unintentional entries remain: 

 Mark the complete plate by clicking on the gray button in the top left of the layout. 

 In the Sample type list select the option Empty. 

 Click on  or press Enter. 

Defining samples 

3. Mark the three wells A1–A3. 

4. Make the following settings: 

5. Click on  or press Enter, to assign the sample properties to the three wells. 

6. Mark the three wells A4–A6. 

 Parameter Entered value  

Sample name Sample 1 

Sample type Unknown 

FAM GAPDH 
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7. Make the following settings: 

8. Click on  or press Enter, to assign the sample properties to the three wells. 

9. Repeat steps 3–8 for the other three samples.  

Use the following parameters: 

Defining the standard samples 

10. Mark the three wells E1–E3. 

11. Make the following settings: 

12. Make the following entries in the Target table: 

Note: The Conc. column in the Target table is only available for the Standard sample type. 

13. From the Unit list, choose a concentration or mass unit. You can select from the following 

units: 

 ng 

 ng/µl 

 ng/ml 

 pg/µl 

 copies 

 copies/µl 

 copies/ml 

 mg/ml 

 Parameter Entered value  

Sample name Sample 1 

Sample type Unknown 

FAM c-myc 

 

 Wells Sample name Sample type Gene/FAM  

B1–B3 Sample 2 Unknown GAPDH 

B4–B6 Sample 2 Unknown c-myc 

C1–C3 Sample 3 Unknown GAPDH 

C4–C6 Sample 3 Unknown c-myc 

D1–D3 Sample 4 Unknown GAPDH  

D4–D6 Sample 4 Unknown c-myc  

 

 Parameter Entered value  

Sample name Std1 

Sample type Standard 

 

 Dye Gene Conc.  

FAM GAPDH 100 
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 IU/µl 

 IU/ml 

 % 

 

14. Click on  or press Enter, to assign the sample properties to the three wells. 

15. Repeat steps 10–13 for the other standards.  

Use the following parameters: 

16. Click on  or press Enter, to assign the sample properties to the three values. 

Note: Connected samples must have the same sample name. 

 The plate layout for a singleplex assay is complete. 

3.4.5 Automatic generation of dilution series/replicates 

If in an experiment dilution series or replicates are measured, the layout creation can be automated.  

1. Mark the well at which the dilution series or the sample replicate sequence should start (start 

at well) or mark an area on the PCR plate for the dilution series or replicates. 

If no area is preselected, the plate is always automatically filled to the rims. 

2. Click on the button  on the Settings/Samples project tab in the layout view. 

 

 Wells Sample name Gene Conc.  

E4–E6 Std. 1 c-myc 100 

F1–F3 Std. 2 GAPDH 75 

F4–F6 Std. 2 c-myc 75 

G1–G3 Std. 3 GAPDH 50 

G4–G6 Std. 3 c-myc 50  

H1–H3 Std. 4 GAPDH 10  

H4–H6 Std. 4 c-myc 10  
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In the window Dilution series/replicates parameters for automatic dilution series and 

replicates can be defined. 

 

Creating a dilution series 

1. The starting concentration, the dilution factor and the number of dilution steps and replicates. 

2. Specify the start point (Start at well) and select whether the entry in the layout table should be 

done line by line or column by column.  

For determination of the start point, the software automatically takes over the currently active 

position in the layout or the first position at the upper left from a group of selected wells. 

Alternatively, the start point can also be defined by manual entry in the corresponding field. 

3. Enter a name for the standard sample and assign dyes to be measured (multiple selections 

are allowed). The standard name for each replicate is added by one digit (GAPDH1, 

GAPDH2, etc.). 

4. Activate the dyes for which dilution series should be created. Select the names genes for the 

standards. A separate treatment of dyes (targets) is possible in such a way. 

5. Click on Set. 

 The dilution series is created automatically by the software and the corresponding data is 

displayed in the layout and the sample table. 
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Creating replicates 

1. Enter the start point (Start at well) and the Number of samples and the Number of replicates.  

For determination of the start point, the software automatically takes over the currently active 

position in the layout or the first position at the upper left from a group of selected wells. 

Alternatively, the start point can also be defined by manual entry in the corresponding field. 

2. Enter a sample name and select whether the entry in the layout table should be done line by 

line or column by column. The sample name for each replicate is added by one digit (Test1, 

Test2, etc.) 

3. Specify the Sample type. 

4. Activate the dyes for which replicates should be created. Select the names genes for the 

samples. A separate treatment of dyes (targets) is possible in such a way. 

5. Click on Set. 

 Replicates are created automatically by the software and the corresponding data is 

displayed in the layout and the sample table. 

3.4.6 Defining groups 

Several experiments can be performed on one microplate at the same time. The samples that are 

part of one experiment are combined in a group. A group contains a number of reaction mixtures 

that will be evaluated together later on. You can define a maximum of 12 such groups. 

The groups are defined in the Settings/Samples project window. 

1. In the Settings/Samples project window click on the Create groups button. 

The Group list and the Group name field are activated. 

In the layout, all samples are marked with the number 1. This means they have been 

assigned to group 1. 

2. In the layout, select the samples that are part of one experiment. To select adjacent positions 

press the left mouse button and define an area. To select non-adjacent positions press the Ctrl 

key on the keyboard plus the left mouse button at each position 

3. Select the next group from the Group list. 

4. Enter the description for the experiment in the Group name field. You may select any group 

name. 

5. Click on  or press Enter, to assign the group properties to the samples. 

The samples that belong together are marked with the group number in the layout. 
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The descriptions are displayed in the sample table in the Group name column. 

 

3.4.7 Layout preview 

The layout preview provides a complete overview of the layout of the PCR plate with samples and 

the corresponding information that has been saved for the samples.  

 Open the layout preview by clicking on the  symbol in the toolbar.  

Optionally, call up the Samples > Preview layout menu command. 

The layout preview is displayed in the View sample plate window. 
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The layout preview provides an overview of the following properties: 

 Position on the PCR plate 

 Genes to be determined  

 Sample type by means of color marking at the edge 

 Underlined in color to indicate group affiliation 

If you move the cursor to a specific position, all known settings for this position, such as sample 

names, sample type and group and all genes and dyes to be measured for the sample as well as 

the concentration in the case of standards are displayed in detail.  

 

The table can be printed and used, for example, as a template for pipetting the samples or for 

documenting the experiment. 

 Press the Print button in the View sample plate window to print the table.  

3.4.8 Copying the layout 

The layout view or parts of the layout can be copied and inserted into another project. 

1. Use your mouse to mark the area in the layout view to be copied. 

2. Transfer the information to the clipboard by clicking on the  symbol in the toolbar.  

Optionally, call up the Samples > Copy layout menu command. 

3. Select the target project.  

4. Paste the information using the  symbol. 

Optionally, you can use the Samples/Paste layout menu command. 
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 The copied areas become inserted at the same position in the target project like their 

position in the source file. 

The way described to edit the layout is related to the graphical presentation of the PCR plate in the 

upper part of the project window. If the layout table shall be edited by copy, cut and paste this can 

be done by using the right hand mouse button and keeping the Ctrl-button pressed. I this way, also 

areas within the same project can be copied. 

1. Press the Ctr-button and hold it pressed during the whole operation. 

2. Mark the lines to be copied or cut by left-clicking the mouse and drawing it up or down. 

3. Press the right mouse button and select the desired function 

 

4. Select the line by left clicking the mouse from which the copied samples shall be inserted. By 

right clicking the mouse the paste menu appears. 

 In the example the standard Std2 is now a sixfold replicate by their identical sample 

name. 

 The selected standard samples including their properties are now copied to the wells B5, 

B6 and B7: 

 

3.4.9 Exporting or importing the layout in Excel 

The layout can be exported or imported as an Excel file (XLS). The exported data can be edited in 

Excel and then reimported. 
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 Right-click on the sample table.  

A context menu with the Import table from Excel file (*.xls) and Export table to Excel file (*.xls) 

menu commands opens. 

Select the desired menu command. 

 

3.4.10 Functions for creating and editing a plate layout 

 Action Where Function  

 Left click a well PCR plate scheme Selects this well  

Double left click a well PCR plate scheme Shows the information assigned to this well in the 
edit fields 

Left click and drag PCR plate scheme Selects consecutive wells 

Ctrl + left click PCR plate scheme Selects this well additionally  

Ctrl + left click and drag PCR plate scheme Selects consecutive wells additionally  

Right click selected wells PCR plate scheme Opens context menu for: 

Assigning and deleting wells which do not contain 
an internal positive control (IPC-, only relevant to 
end point analysis) 

Assigning genes afterwards  
(The gene names shown in the edit field will be 
assigned to the selected wells.) 
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 Action Where Function  

ENTER Keyboard Complies with function assig 

(symbol  placed near the edit field Sample 
name  or in the toolbar) 

 

DEL Keyboard Deletes the information assigned to the well and 
changes sample type to „Empty” 

 

Function button F5 Keyboard/edit field  „Gene” Removes the selected gene from the displayed  list 
of genes  

 

Left click on the table header, 
column Well 

Table Changes sort sequence from „by line” to „by 
column” or vice versa  

 

Right click on the table header Table Opens context menu for selection of the columns to 
be displayed in the table 

 

Right click and drag on the table 
header 

Table Changes the sequence of the columns  

Left click on a line  Table Highlights this line an allows for data input or 
selection of sample types, directly in the table 

 

Right click on a line Table Opens context menu for: 

exporting the layout table to Excel 

importing the layout table from Excel 

 

Ctrl + right click (+ drag) on a 
line of the table 

(holding Ctrl pressed) 

Table Opens context menu to copy, cut, paste or delete 
the contents of the selected table lines  

 

Symbol  below the target 
table 

Edit field Opens dialog for automatically creating dilution 
series and replicates  

 

Double-click on the color cell in 
the table row 

Table Opens the Color window for selecting the color of 
the amplification curve. 

 

Shift key and double-click on 
color cell 

Table Resets the color setting of the amplification curve to 
the default setting in the Options/Color window. 

 

Ctrl + double-click on color cell Table Opens the Edit color window. A selected color can 
be allocated to the amplification curves of multiple 
wells at the same time. 

 

 

 

 

1: PCR plate scheme 
2: Edit fields 
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4 Monitoring 

All functions required for starting and monitoring a Real-Time PCR run are combined on the 

Monitoring project tab. 

Note: After the PCR run is finished you have the choice to save the project or to continue without 

saving. If you save the project you cannot change the settings anymore and, for data integrity, it is 

not possible to start a new PCR run from that project. If you want to start a new PCR run with the 

same settings you must first generate a template from the project and then open it. 

4.1 Starting the PCR protocol 

Activate the Monitoring tab in the project window to display the symbols for starting the PCR and 

the Monitoring menu protocol defined in the Settings project window in the tool bar. 

 Symbol Monitoring Description  

 

Start qPCR run 

 

Start the PCR run 

 

Stop qPCR run The PCR run is interrupted and will not be continued. 
The data recorded up to this point is saved and can be evaluated. 

 

Pause qPCR run The PCR run is interrupted. The symbol flashes during the break. The PCR run can 

be continued by clicking  again. 

 

View options Defines default settings for the Monitoring view. 
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4.2 Display options for monitoring 

The Monitoring project window is divided into the following areas: 

 
 

1: Measuring results Displays the measured fluorescence data. The fluorescence intensity is plotted against the cycle. 

2: Colors tabs Switches between fluorescence accumulation curves that were measured for the individual dyes. 

3: PCR protocol Displays the PCR protocol. The active step is indicated by a green arrow. 

4: Protocol view tabs Switches between different views of the PCR protocol (tabular, graphic, temperature profile). 

The fluorescence measurements are displayed in the top area. On the different list sheets you can 

choose between the overlapping display of the measurement results of all dyes or the display of the 

individual dyes.  
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In the View list you can switch between the Amplification, Melting curve, and Raw data views. The 
Ct value can be calculated for the amplification and the melting temperature Tm for the melting 
curve. 

The current PCR protocol is displayed at the bottom of the table in the project window. The active 

step is marked by means of a green arrow during the PCR run. On the different sheets you can 

choose between a tabular or graphical view of the PCR protocol or the temperature profile. The 

view of the PCR protocol is described in the section “Monitoring the PCR run“, page 67. 

Note: For each amplification curve a short information is displayed when the mouse pointer is 

placed it (mouse-over function). 

4.2.1 Default settings for the Monitoring view 

For all views in the Monitoring project window it is generally possible to choose between linear 

and logarithmic scaling for the graphical display of the data. The setting for the baseline correction 

can also be changed.  

 Select the Monitoring > Display options menu command or click  in the toolbar. 
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4.2.2 Adjusting the view in the Monitoring project window 

In the Monitoring project window, you can adjust the preset parameters (Monitoring > Display 

options menu command) for the display of the scaling as well as the range limits for the baseline 

correction. 

1. Click on the  button above the chart. 

A selection field for setting the display options and entering the baseline parameters opens. 

  

For all samples baseline correction parameter Sample specific baseline correction parameter 

2. Change the baseline correction limits and activate the linear or logarithmic option for the 

desired view of the fluorescence curves. 

 Parameter/Option Description  

Smoothing Setting the smoothing conditions for the measured data 

Scaling Scaling options for the data (linear or logarithmic) 

Baseline correction There are two options for the baseline correction: 
 For all samples 

If this option is selected, the baseline for every sample in the same range is determined. 
The upper and lower range limit must be set in the From cycle and To cycle fields. 

 Sample specific 
Select this option if the curves have significantly different Ct values. The lower range limit 
for determining the baseline is set in the Crop first cycles field for all samples. The upper 
range limit is determined separately for each sample by an algorithm. 

Note: The type of baseline correction can only be set in this dialog. The range limits for the 
correction can also be adjusted in the project window. 
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4.2.3 Displaying and hiding measurement results for individual wells 

The sample view in the Monitoring project window is controlled via the Samples menu item in the 

project explorer. Measurement results in the individual wells can be hidden or shown.  

Note: The selection in the project explorer only influences the display of the fluorescence data but 

not the measurement. 

 

The color code for each sample type can be modified in menu Extras/Options > colors. 

The marking of the sample assignment corresponds to the marking on the Samples project tab: 

Active wells (i.e., displayed wells) are marked with their sample type symbol. For deactivated wells 

the position is grey and the fluorescence data is hidden. Empty wells are marked “E”. By default 

measurement data for empty wells is not shown. For control by activating empty wells the 

measurement data can be displayed.  

 Click with the mouse to switch. The activation changes with each click on a well. 

 Sample type Symbol Definition  

Empty E Describes an empty position on the PCR plate 

Unknown U Sample of unknown concentration or dilution (measuring sample) 

Standard S Sample of known concentration or dilution 

Calibrator K Sample whose gene of interest expression level is set as 1 

No template control (NTC) N Complete reaction preparation but without matrix strand  

Positive control + Positive control preparation for which a reaction product is expected  

Negative control - Negative control preparation for which no reaction product is expected  
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 You can change adjacent wells by holding the mouse button and moving the cursor over the 

wells. To select nonadjacent positions press the Ctrl key on the keyboard plus the left mouse 

button at each position. 

 Complete rows and columns can be inverted by clicking on the letter or number of the row A–

H or column 1–12. 

 The activation status of the complete plate can be inverted by clicking on  on the top left 

between A and 1. 

 To activate all wells click on the  symbol below the chart. 

 To activate only samples of a specific type click on the corresponding symbol below the chart. 

To activate multiple sample types at the same time keep the Ctrl key pressed when clicking on 

the sample types. 

4.2.4 Exporting fluorescence data 

The data from the fluorescence measurement can be exported as CSV files. In addition, the 

graphical display of the measurement results can be copied to the clipboard as a hardcopy and is 

hereby made available for other programs.  

 Right-click on the graph. 

 A selection window for export and hardcopy appears. 

 Click on Copy chart to copy the chart to the clipboard. 

 Select the Save chart as CSV-File option to export the fluorescence data. 

The Save as standard window opens. 

Enter a file name and confirm with OK. 
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4.3 Monitoring the PCR run 

The running PCR protocol is shown in the bottom part of the Monitoring project tab. It is generally 

possible to choose between the four different views (list sheets) Graph, Table, Gradient and T-Profile 

via tabs. 

In addition to the display on the list sheets a status bar shows further information on the protocol, 

such as the plateau time, the calculated remaining time and, in programmed loops, the step number 

and the number of loops. 
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Table list sheet 

 
Monitoring project window with PCR protocol table 

Table 1.  

Graph list sheet 

 
Monitoring project window with PCR protocol table 

The Graph list sheet contains the same elements of the graphical representation of the PCR protocol 

as the Settings/Thermocycler/Graph project window. Once again, the active step is marked by a 

green arrow. 

 Element Description  

Lid Current lid temperature 

Temperature display Current block temperature 

Steps Temperature steps in the PCR protocol 

The active step is marked by a green arrow. 

°C Target temperature of the step 

m:s Hold time, format: min:s 
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T profile list sheet 

 
Monitoring project window with T profile 

In the representation of the temperature profile a yellow progress bar indicates the step that is 

currently being performed. 

The size of the area displayed for fluorescent curves and results table or standard curves can be 

adjusted by the slider control that is located between the two areas. 

 
Slide control to adjust the size of the displayed areas 

4.4 Displaying product accumulation curves and calculating Ct values 

The product accumulation is documented by means of fluorescence measurements during the PCR 

run in the project window Monitoring.  

Displaying the product accumulation curve 

 Select the Amplification or Raw data option from the View list to display measurement curves 

for the product accumulation. 

In the chart the fluorescence intensity I is plotted against the number of cycles in relative units. 

The color of the curve that is being displayed corresponds to the color assigned to each well 

in the sample table (Settings/Sample project window). 

 Selected the measurement results for the individual dyes via the corresponding list sheets.  

You have the option to display the measurement results of all dyes together (all colors list 

sheet) or only the results of an individual dye. 
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The display options for the product accumulation curves are described in the section “Display 

options for monitoring“, page 62. 

Calculating the Ct values 

After the PCR run, the Ct values can be calculated directly from the amplification curves, without 

having to create an analysis such as Absolute quantification. 

 Select the Amplification or Raw data option from the View list and click Calculate Ct. 

The amplification curves are normalized and displayed individually or together on the list 

sheets for the dyes. The table below shows the Ct values of the individual samples and the 

mean values of the replicates. 

The threshold value for the individual dyes can be set on the applicable list sheet. The 

parameters set in the Options/Analysis window are factored in. 

 After clicking on Data, you return to the display of the fluorescence intensities. 

 

Export of data 

 

The Amplification data, Raw data, and Ct values can be exported individually as *.csv file by 

right-clicking into the respective graph or table and selecting Save Graph/Table as CSV file 

(*.csv). 

 

To export all data within one single *csv file, right-click into the table displaying the Ct values and 

select Export LIMS as CSV-File (*.csv). 

 

4.5 Displaying melting curves and calculating the melting temperatures 
Tm 

Displaying melting curves 

The course of the melting curve after the PCR can be monitored in the Monitoring project window. 

 To display the melting curves, select the Melting curve option from the View list.  

The display options for the product accumulation curves are described in the “Display options for 

monitoring“, page 62. 
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Calculating the melting temperature Tm 

For a PCR run with included melting curve, the melting temperatures can be calculated in the 

Monitoring window without having to create a Melting curve analysis. 

 In the Monitoring project window, select the Melting curve option in the View list. 

 Click on Calculate Tm. 

 Select the gene to be examined in the Gene of Interest (GOI) list. 

 The melting temperature is calculated taking the parameters set in the Options/Analysis 

window into account, and the diagram and the results table are displayed. 

 As an option, a threshold value can be set on the Derivative tab, with which significant peaks 

can be distinguished from insignificant ones. 

 After clicking on Data, you return to the display of the fluorescence intensities. 

 
Monitoring project window with calculation of the melting temperature 
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5 Evaluation 

On the Analysis tab of the project window the following methods are available for evaluating Real-

Time PCR experiments on 6 cards: 

 Absolute quantification 

 Relative quantification 

 ΔΔCt method 

 Melting curve determination  

 Genotyping 

 POS/NEG analysis at the end point 
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The individual evaluation methods can be accessed via the subordinated tabs. For each selection 

method different evaluations can be created. 

Toolbar and menu commands are adjusted to the requirements of the selected method tab.  
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5.1 General functions in the evaluation project window 

5.1.1 Making basic settings 

Presets can be made for some evaluation parameters. 

1. Click on  in the toolbar. 

2. Set up the following parameters. 
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More setting options may be available depending on the analysis method used. They are explained 

separately in the respective sections. All items displayed on the Analysis project tab can also be 

accessed quickly via the settings area of the baseline and displayed as linear or logarithmic 

representations. For this purpose, a selection for display options can be opened in the 

corresponding window via the right-arrow button : 

 

 

For all samples baseline correction parameter Sample specific baseline correction parameter 

5.1.2 Activating/deactivating samples for evaluation 

Samples from individual wells can be activated or deactivated for evaluation in the project explorer 

Samples menu item. This enables you, for example, not to include excessive values when calculating 

mean values. 

 Option Function  

Smoothing Smoothing the fluorescence curves on the basis of the calculated moving average over a range 
of 2 to 12 measuring points or representation without smoothing 

Scaling Linear or logarithmic representation of fluorescence curves 

Baseline correction At the correction of the base line you can choose between two options: 
• For all samples: At this correction the base line is determined for every sample in the 

same area. The lower and upper area limit has to be edited in the fields From cycle and 
To cycle. 

• Sample specific: This correction should be chosen if the curves have very different Ct 
values. The lower area limit for the determination of the base line will adjusted in the 
field Crop first cycles for all samples. The upper area limit is separately found out by an 
algorithm for each sample. 

Note: The manner of the base line correction can be selected only in this dialog. The area limits 
can, however, be adapted for the correction in the project window.  

Autom. threshold Calculation of the threshold as a deviation of x times of the standard deviation of the baselines 
(factor can be adjusted under Extras/Options/Analysis in the main menu) or based on defined 
standards with the goal to get the maximum value for the coefficient of determination R2 

Filter Digital filter for smoothing the fluorescence curves. Adjustable in steps: slight, medium, and 
strong 

 

Cancel noise Curves with high background noise that are not interpreted as amplification curves by the 
software are set to 0 and no Ct values are calculated. 

 

Auto threshold The threshold line is calculated new when changes to the basic settings are made.  

Fix threshold The set threshold line is maintained when changes to the basic settings are made.  
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Note: The selection in the project explorer only influences the analysis of the fluorescence data. 

Measured data will not be deleted. 

 

The marking of the sample assignment corresponds to the marking on the Samples project tab. The 

color code for each sample type can be modified in menu Extras/Options > colors. 

 
Active wells (i.e., wells included in the analysis) are marked with their sample type symbol. For 

deactivated wells the position is grey and the fluorescence data is hidden. Empty wells are marked 

“E”. 

 Click with the mouse to switch. The activation changes with each click on a well. 

 You can change adjacent wells by holding the mouse button and moving the cursor over the 

wells. 

 Complete rows and columns can be inverted by clicking on the letter or number of the row A–

H or column 1–12. 

 The complete plate can be inverted by clicking on  on the top left between A and 1. 

 To activate all wells click on the  symbol below the chart. 

 Sample type Symbol Definition  

Empty E Describes an empty position on the PCR plate 

Unknown U Sample of unknown concentration or dilution (measuring sample) 

Standard S Sample of known concentration or dilution 

Calibrator K Sample whose gene of interest expression level is set as 1 

No template control (NTC) N Complete reaction preparation but without matrix strand  

Positive control + Positive control preparation for which a reaction product is expected  

Negative control – Negative control preparation for which no reaction product is expected  
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 To activate only samples of a specific type click on the corresponding symbol below the chart. 

To activate multiple sample types at the same time keep the Ctrl key pressed when clicking on 

the sample types. 

5.1.3 Exporting fluorescence data 

The data from the fluorescence measurement can be exported as CSV files. In addition, the 

graphical display of the measurement results can be copied to the clipboard as a hardcopy and is 

hereby made available for other programs.  

 Right-click on the graph. 

 A selection window for export and hardcopy appears. 

 Click on Copy chart to copy the chart to the clipboard. 

 Select the Save chart as CSV-File option to export the fluorescence data. 

The Save as standard window opens. 

Enter a file name and confirm with OK. 

 

5.1.4 Configure results table 

For each analysis the results are summarized in a table that is accessible by the tab Table. 
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Depending on the analysis method the results table contains different data sets but for each table 

the view and selection of columns to be displayed can be configured user-defined: 

 By click with the right mouse button on a column header a box is displayed in which single 

columns can be selected or deselected to be shown in the table. 

 By dragging a columns header with pressed left mouse button columns can be exchanged 

against each other and the arrangement modified. 

 By click with the left mouse button on the left or right border of a columns header the width 

can be modified. 

 By click with the left mouse button on a columns header the data becomes arranged 

ascending or descending (by number or alphabetically). 

 The colors of the amplification curves can be changed after double-clicking on the color cell in 

the table row. 

Press the Ctrl key and double-click the Edit color window to set the color for multiple wells (see 

section “Entering sample properties into the sample table”, page 47). 

 By click with the left mouse button on the column „Well” the display of data switches between 

column- or row-wise representation of the results. The column- or row-wise representation is 

based on the arrangement of samples in the layout.  

5.1.5 Export results 

The results table can be exported as XLS or CSV file. 

 Click with the right mouse button on the results table. 

A context menu opens with the commands Save Table as Excel-File (*.xls), Save Table as Excel-

File (*.xls) and run Excel, and Save Table as CSV-File (*.csv). 

 Select the corresponding command. 

The standard Windows dialog Save as opens. Enter a name for the file and confirm the 

settings with OK. 

 Symbol Meaning  

 
Display of data by columns 

 
Display of data by rows 
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Note: User defined configurations of the results table are included in the exported data set (see 

section “Configure results table“, page 77). 

 

5.2 Absolute quantification 

The absolute quantification is used to determine absolute copy numbers in samples with the help of 

the comparison with standards with known concentrations.  

5.2.1 Creating an evaluation for an absolute quantification 

1. Go to the Analysis/Abs quant project tab. 

If the tab is not visible, click on the arrows  in the tab bar. This will scroll the tabs. 

2. Click on the  symbol in the toolbar. 

Optionally, call up the AbsQuant > Add abs. quantification menu command. 

3. An input window appears. Enter the description for the current evaluation. 

4. On the AbsQuant tab the following information is activated: 

 Parameter settings (1) 

 Display of fluorescence spectra (2) 

 Display of result table with measurement results (3) 

 Display of the standard curves and the calculated coefficients (4) 
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5.2.2 Setting parameter for absolute quantification 

 

Set the following parameters for the absolute quantification: 
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Setting the threshold value 

To determine Ct values for the evaluation, a threshold value needs to be determined for each 

experiment first.  

You have several options for setting the threshold value: 

 In the general options (see section “Making basic settings“, page 74). 

 Manually in the parameters for the respective evaluation (see table above) 

 Graphically in the fluorescence curves representation: 

In the chart, move the black threshold line up or down with the cursor. Press and hold the left 

mouse button while doing so. At the same time, the Ct values in the result table are updated. 

Note: Due to the further spread of the early exponential area of the product accumulation 

curves, a logarithmic representation is better suited for setting the threshold manually in the 

display range than a linear representation. 

 By automatic calculation: 

The automatic calculation of the threshold value is activated by clicking on the  symbol. 

Alternatively, you can call up the AbsQuant > Autom. Threshold menu command. 

Whether you choose manual or automatic calculation, the resulting threshold value is updated and 

displayed synchronously in the corresponding Threshold input field. 

 Option Description  

Selection list Selection of an evaluation created for the experiment 

Gene of interest 
(GOI) 

Selection list of target gene/dye combinations 

According to the selection, the fluorescence and regression curves for the concentration are 
displayed. 

Include pass. 
reference 

Only active if a dye has been defined as a passive reference on the Settings/Scan project tab 

If this option is activated, the fluorescence of the dye that has been set as a passive reference is 
used for standardization. 

Group If several experiments were carried out on the PCR plate, select the group of the experiment to be 
analyzed (see section “Defining groups”, page 55). 

Threshold Manually adjust threshold value 

The threshold value must be between 1 and 100, depending on the standardized representation 
of the fluorescence curves (dRn). 

Note: The threshold value can be calculated automatically or set manually in the chart (see also 
“Setting the threshold value” below). 

 

 
Opens the selection window with display options (see section “Displaying the fluorescence curves 
for absolute quantification“, page 82). 
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Fix Threshold 

The threshold value becomes recalculated by the software each time basic settings for the analysis 

are changed. For the analysis the option Fix Threshold can be used, so that the threshold value is 

retained if the basic settings for the analysis are changed (see section “Making basic settings“, 

page 74). 

5.2.3 Displaying the fluorescence curves for absolute quantification 

In the display range, the measured data, standardized to the value 100 for highest fluorescence 

intensity, is plotted against the cycle for the selected target gene.  

The respective fluorescence curves are displayed by switching to another target gene/dye 

combination.  

The fluorescence data is displayed as a linear or logarithmic representation depending on the 

selected display option. For both display options the program shows brief information on the sample 

if the cursor is placed on one of the curves. 

Switching the display options for the chart 

1. Click on the  button in the parameter bar. 

A selection window for the display options opens. 

2. Select the Scaling logarithmic or linear option.  

Click next to the selection window. The changes are applied. 

 
Linear representation of the fluorescence curve for the absolute quantification 
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Logarithmic representation of the fluorescence curve with horizontal threshold line 

5.2.4 Display of the mean Ct values or mean concentrations 

After selecting the tab Mean. Ct or Mean. conc. the display changes to a presentation of the results 

as bar chart. The respective sample name is given below each bar. The height of the bar is 

determined by the mean Ct-value or the calculated mean concentration of replicates. For each bar 

some short information about the position of the samples, the mean value and the calculated 

standard deviation is shown if the mouse pointer is placed on it. The size of the standard deviation 

is shown as error bar on top of each bar. Since for large numbers of samples not all bars can be 

displayed in the screen the diagram can be moved horizontally with pressed left mouse button and 

dragged to the desired position. 

 
Bar chart for the display of mean Ct values of replicates 
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Bar chart for the display of mean concentrations of replicates 

5.2.5 Displaying the standard curve and results of an absolute quantification 

In the bottom Standard curve section of the Analysis project window, you can switch between the 

calculated standard curve and the result table via the Curve and Table list sheets. 

For the display of the standard curve the Ct values of the standard samples are plotted graphically 

against the logarithm of their concentration. In the value range on the right the following calculated 

data is displayed: 

 The coefficient of determination R2 of the linear equation 

 The standard curve gradient 

 The intersection of the curve with the y-axis at x=0 (offset) 

 The PCR efficiency  

The standard curve and the values are automatically calculated by the QIAquant 96 Software and 

updated in case of settings modifications. 
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The result table for the absolute quantification contains all data and the associated measurement 

values for the samples.  

 

For the absolute quantification the results table contains the following information: 

Display in the project explorer 

A shortened representation of the standard curve calculated by the software is displayed in the 

project explorer under Abs. quant. The image displays the graphical plot of the Ct values of the 

standard samples against the logarithm of their concentration: 

 Column Description  

Well Position of sample 

color of curve Each sample is automatically assigned an unchangeable color which is used to display the 
corresponding fluorescence curve 

Sample name Name of sample 

Sample type Type of sample 

Group Assignment of the sample to an experimental group  

Gene Name of gene measured in the sample  

Ct Ct value of sample  

Mean. Ct Mean Ct value of replicates  

Conc. Std Concentration of the standard sample  

Mean conc. Concentration determined from the standard curve on the basis of the mean Ct value  

StdDev. Ct Standard deviation of the Ct values between replicates  

%CV Ct Variation coefficient of the Ct values between replicates  

StdDev. Mean conc. Standard deviation of the mean concentration  
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5.2.6 Exporting results of calculations 

Exporting measurement data and results of calculations enables you to perform more extended data 

analysis by using dedicated software. 

Excel and CSV 

You can design the results table according to your requirements by setting type, sequence and 

width of the columns to be displayed. You can also adjust the sort sequence of data in the column 

(alphabetical, numerical, by column, by row). The table configured this way can be exported as 

Excel or CSV file by right clicking the table. 

 

Export to qBASE+ 

qBASE+ is a software which allows for a more detailed statistical analysis of your qPCR data. For 

information see www.biogazelle.com. Using the analysis module ‘Absolute Quantification’ of 

QIAquant 96 Software you can export qPCR data to a file which can be read and analyzed by 

qBASE+.  

1. In order to export qPCR data for use in qBASE+ click the symbol  in the toolbar.  

Alternatively you can select the menu Absolute Quantification/qBASE Export.   

2. Choose the targets shall be exported and the data format shall be used (qBASE+ is able to 

read both formats) in next dialogue. 

http://www.biogazelle.com/
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The following information is sent to qBASE+: 

 Well 

 sample type 

 sample name 

 gene name 

 Ct value 

 concentrations of standards 

 sample active/inactive 

 

Note: Only those genes are displayed in the export dialogue which were set as GOI before. 

Therefore in multiplex assays for each GOI, i.e., each dye, an absolute quantification must be 

defined. To do so repeat the steps explained in section “Creating an evaluation for an absolute 

quantification“, page 79, topic 2 and 3, for each GOI. 

5.2.7 Importing the standard curve 

Next to the option to measure a standard curve in the experiment, the QIAquant 96 Software can 

also be used to determine the concentration of the samples based on the saved standard curve. 

You can use the import function for this purpose.  

1. Use the  symbol in the toolbar to open the Import standard curve window. 

Optionally, you can call up the AbsQuant/Import standard curve menu command. 

The mathematical equation that the standard curve is based on and the associated dye are 

each displayed in the list fields of the window. 
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2. Select one of the import options from the Import standard curve window and make the 

corresponding entries: 

5.2.8 Deleting the evaluation of an absolute quantification 

An evaluation that is no longer required can be removed. 

1. Activate the evaluation by selecting its description in the evaluation list of the method tab. 

2. Click on  in the toolbar. Optionally, you can call up the Absolute quantification > Delete 

evaluation  menu command. 

The evaluation is removed.  

5.3 Relative quantification 

Relative quantitation allows for determination of the relative expression level of a gene of interest 

in relation to one or more reference genes (often  housekeeping genes). If one of the samples is 

denoted as the calibrator , the expression level of that sample is set to unity and the relative 

expression levels of all the other samples are given in relation to the calibrator sample. For relative 

quantification standard dilution series are required for the gene of interest as well as for the 

reference genes. 

5.3.1 Creating a new evaluation for a relative quantification 

1. Go to the Analysis/RelQuant project tab. 

If the tab is not visible, click on the arrows  in the tab bar. This will scroll the tabs. 

2. Click on the  symbol in the toolbar. 

Alternatively, call up the RelQuant > Add rel. quantification menu command. 

3. An input window appears. Enter the description for the current evaluation. 

 Option Meaning  

Import from this run Imports a standard curve from the current open project. 
If several standard curves are saved in one project, all curves are displayed and you can 

make a selection. 
Import from saved run Imports a standard curve from a saved project. 

If several standard curves have been saved, select the corresponding curve from the list. 

Manual input Standard curve coefficients are entered manually. 
Enter the gradient and the intercept for the equation 
Ct = gradient * log(conc) + intercept. 

Delete External 
Standards 

Deletes imported or entered standard curves so that they are no longer used for analysis 
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On the Rel. Quant. tab the following information is activated: 

 Parameter settings (1) 

 Display of the fluorescence curves for the target gene and the reference gene (2) 

 Display of the result table with the added values (3) 

 Display of the standard curves for the target gene and the reference gene and the calculated 

coefficients (4) 

 
 

Note: If multiple replicates have been used and one replicate or more of the reference gene does 

not show a Ct value, the calculation will be adjusted to use only the Ct values from the replicate(s) 

with a Ct value. 
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5.3.2 Parameter settings for relative quantification 

 

The following parameters must be set for the relative quantification: 

Setting the threshold value 

To determine Ct values for the evaluation, a threshold value needs to be determined for each 

experiment first.  

You have several options for setting the threshold value: 

 In the general options (see section “Making basic settings“, page 74) 

 Option Description  

Selection list Selection of an evaluation created for the experiment 

Gene of interest 
(GOI) 

Selection list of target gene/dyecombinations 

According to the selection, the fluorescence and regression curves for the concentration are 

displayed. 

Only one target gene at a time can be selected. 

Reference genes Reference gene selection list 

In contrast to the target gene, several reference genes can be selected at the same time. The 

number of list sheets in the display range therefore grows with each reference gene. 

The  symbol is used to remove all reference gene settings from the evaluation. 

Include pass. 
reference 

Only active if a dye has been defined as a passive reference on the Settings/Scan project tab. 

If this option is activated, the fluorescence of the dye that has been set as a passive reference is 
used for standardization. 

Group If several experiments were carried out on the PCR plate, select the group of the experiment to 

be analyzed (see section “Defining groups”, page 55). 

 

Threshold Manually adjust threshold values 

The threshold value must be between 1 and 100, depending on the standardized 

representation of the fluorescence curves (dRn). 

Note: The threshold value can be calculated automatically or set in the graph. 

 

 Opens the selection window with display options  
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 Manually in the parameters for the respective evaluation (see table above) 

 Graphically in the fluorescence curves representation: 

In the chart, move the black threshold line up or down with the cursor. Press and hold the left 

mouse button while doing so. At the same time, the Ct values in the result table are updated. 

Note: Due to the further spread of the early exponential area of the product accumulation 

curves, a logarithmic representation is better suited for setting the threshold manually in the 

display range than a linear representation. 

 By having it calculated automatically: 

The automatic calculation of the threshold value is activated by clicking on the  symbol. 

Alternatively, you can call up the RelQuant > Autom. Threshold menu command. 

Whether you choose manual or automatic calculation, the resulting threshold value is updated and 

displayed synchronously in the corresponding Threshold input field. 

Fix Threshold 

The threshold value becomes recalculated by the software each time basic settings for the analysis 

are changed. For the analysis the option Fix Threshold can be used, so that the threshold value is 

retained if the basic settings for the analysis are changed (see section “Making basic settings“, 

page 74). 

5.3.3 Displaying the fluorescence curves in the relative quantification 

In the display range, the measured data, standardized to the value 100 for highest fluorescence 

intensity, is plotted against the cycle for the selected target gene. The target gene/dye and the 

reference gene/dye combinations are each assigned a list sheet that can be activated by clicking 

on the gene/dye tab on the bottom. 

Since only one target gene/dye combination is permitted at a time, the fluorescence curves of the 

selected combination are displayed whenever a new combination is selected. The number of the 

available list sheets depends on the number of the selected reference genes. 

The fluorescence data is displayed as a linear or logarithmic representation depending on the 

selected display option. For both display options the program shows brief information on the sample 

if the cursor is placed on one of the curves. 

Switching the display options for the chart 

1. Click on the  button in the parameter bar. 
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A selection window for the display options opens. 

2. Select the Scaling logarithmic or linear option.  

Click next to the selection window. The changes are applied. 

 
Linear representation of the fluorescence curve for the relative quantification 

 
Logarithmic representation of the fluorescence curve for the relative quantification with horizontal threshold line 

5.3.4 Display of the normalized relative concentrations 

After selecting the tab Norm. rel. conc. the display changes to a presentation of the results as bar 

chart. The respective sample name is given below each bar. The height of the bar is determined by 

the mean Ct-value or the calculated mean concentration of replicates. For each bar some short 

information about the position of the samples, the mean value and the calculated standard deviation 

is shown if the mouse pointer is placed on it. The size of the standard deviation is shown as error 

bar on top of each bar. Since for large numbers of samples not all bars can be displayed in the 

screen the diagram can be moved horizontally with pressed left mouse button and dragged to the 

desired position. 
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5.3.5 Displaying the standard curves and the results of a relative quantification 

In the upper area of the project window you can switch between the display of the calculated 

standard curves for the target gene and all selected reference genes and the result table for the 

relative quantification using the Standard curve and Table list sheets.  

For the display of the standard curve the Ct values of the standard samples are plotted graphically 

against the logarithm of their concentration. For the respective data points errors bar are shown 

that indicate the standard deviation between replicates. For each data point some short information 

about the sample name and the size of the standard deviation of replicates is shown if the mouse 

pointer is placed on it. In the value range on the right the following calculated data is displayed: 

 the coefficients of determination R2 of the linear equation 

 the standard curve gradients 

 the intersections of the curves with the y-axis at x=0 (offset) 

 the PCR efficiency 

When more than one standard curve is displayed each curve has its individual color. Accordingly 

each table has a color code in the header that reflects the assignment to the respective standard 

curve. The standard curve and the values are automatically calculated by the QIAquant 96 Software 

and updated in case of settings modifications. According to the number of genes used a scroll bar 

appears under the table. It can be used to navigate through the table's columns. 
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The result table for the relative quantification contains all data and the associated measurement 

values for the samples.  

 

For the relative quantification the results table contains the following information: 

 Column Meaning  

 Well Position of sample  

Color of curve Each sample is automatically assigned an unchangeable color which is used to display the 
corresponding fluorescence curve 

Sample name Name of sample 

Sample type Type of sample 

Group Assignment of the sample to an experimental group  

GOI Gene of interest  

Reference gene Reference gene  

Ct GOI Ct value of gene of interest  

Ct Reference gene Ct value of reference gene  

Mean. Ct GOI Mean Ct value of replicates of the gene of interest  

Mean. Ct Ref.gen Mean Ct value of replicates of the reference gene  

Conc. Std. GOI   Concentration of the standard for the gene of interest  

Conc. Std Ref.gen  Concentration of the standard for the reference gene  

Mean Conc. GOI Concentration for the gene of interest determined from the standard curve on the basis of the 
mean Ct value 

 

Mean Conc.. Ref. 
gen 

Concentration for the reference gene determined from the standard curve on the basis of the 
mean Ct value 
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 Column Meaning  

Std.Dev. Ct GOI Standard deviation of the Ct values between replicates of the gene of interest  

Std.Dev. RefGen Standard deviation of the Ct values between replicates of the reference gene  

%CV Ct GOI Variation coefficient of the Ct values between replicates of the gene of interest  

%CV Ct RefGen Variation coefficient of the Ct values between replicates of the reference gene  

Relative Conc. Relative (x-fold) expression level of the gene of interest in relation to the reference gene  

Norm. Rel. Conc.   Relative (x-fold) expression level of the gene of interest in relation to the reference gene, 
standardized to the expression of the calibrator (if defined) 

 

Std.Dev. Relative 
Conc. 

Standard deviation of the relative concentrations   

Std.Dev. Norm. Rel. 
Conc. 

Standard deviation of the normalised relative concentrations   

 

Display in the project explorer 

A shortened representation of the standard curves calculated by the software is displayed in the 

project explorer under Relative quantification. The image displays the graphical plot of the Ct values 

of the standard samples against the logarithm of their concentration. 

 

5.3.6 Importing the standard curve for relative quantification 

Next to the option to measure a standard curve in the experiment, the QIAquant 96 Software can 

also be used to determine the concentration of the samples based on the saved standard curve. 

You can use the import function for this purpose. 

1. Use the  symbol in the toolbar to open the Import standard curve window. 

Optionally, you can call up the RelQuant > Import standard curve menu command. 

2. All additional setting are analogous to the settings for the absolute quantification (see section 

“Importing the standard curve“, page 87). 
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5.3.7 Deleting the evaluation of a relative quantification 

An evaluation that is no longer required can be removed. 

1. Activate the evaluation by selecting its description in the evaluation list of the method tab. 

2. Click on the  symbol in the toolbar. 

Alternatively, call up the RelQuant > Delete rel. quantification menu command. 

The evaluation is removed.  

5.4 ΔΔCt method 

The ΔΔCt-method allows for determination of the relative expression level of a gene of interest in 

relation to one or more reference genes (often housekeeping genes). One of the samples has to be 

denoted as the calibrator. The expression level ofthe calibrator is set to unity and the relative 

expression levels of all the other samples are given in relation to the calibrator sample. In ΔΔCt-

method there is no need to measure standard dilution series. However, if the ΔΔCt-method shall be 

validated within the same PCR run standard dilution series must be defined. 

5.4.1 Creating a new evaluation for a ΔΔCt method 

1. Go to the Analysis/ddCt quantification project tab. 

If the tab is not visible, click on the arrows  in the tab bar. This will scroll the tabs. 

2. Click on the  symbol in the toolbar. 

Alternatively, call up the DeltaDeltaCt/Add ddCt quantification menu command. 

3. An input window appears. Enter the description for the current evaluation. 

On the DeltaDeltaCt tab the following information is activated: 

 Parameter settings (1) 

 Display of the fluorescence curves for the target gene and the reference gene (2) 

 Display of the result table with the added values (3) 

 If standards have been defined, display of the standard curve (4) and the validation curve (5) 

for the expression level of the gene of interest in relation to the reference gene and the 

calculated factors 
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Note: If multiple replicates have been used and one replicate or more of the reference gene does 

not show a Ct value, the calculation will be adjusted to use only the Ct values from replicate(s) with 

a Ct value. 

 

5.4.2 Parameter settings for the ΔΔCt method 

 

The following parameters must be set for the ΔΔCt method: 
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Setting the threshold value 

To determine Ct values for the evaluation, a threshold value needs to be determined for each 

experiment first.  

You have several options for setting the threshold value: 

 In the general options (see section “Making basic settings“, page 74). 

 Manually in the parameters for the respective evaluation (see table above) 

 Graphically in the fluorescence curves representation: 

In the chart, move the black threshold line up or down with the cursor. Press and hold the left 

mouse button while doing so. At the same time, the Ct values in the result table are updated. 

Note: Due to the further spread of the early exponential area of the product accumulation 

curves, a logarithmic representation is better suited for setting the threshold manually in the 

display range than a linear representation. 

 By having it calculated automatically: 

The automatic calculation of the threshold value is activated by clicking on the  symbol. 

Optionally, you can call up the DeltaDeltaCt > Autom. Threshold menu command. 

Whether you choose manual or automatic calculation, the resulting threshold value is updated and 

displayed synchronously in the corresponding Threshold input field. 

 Option Description  

Selection list Selection of an evaluation created for the experiment 

Gene of interest (GOI) Selection list of combinations of measured dyes and target genes to be quantified 

Only one target gene at a time can be selected. 

Reference genes Selection list for the reference genes 

In contrast to the target gene, several reference genes can be selected at the same time. 

The number of list sheets in the display range therefore grows with each reference gene. 

With the  symbol you can remove all selected reference genes from the selection. 

Group If several experiments were carried out on the PCR plate, select the group of the experiment 
to be analyzed (see section “Defining groups”, page 55). 

Threshold Manually adjust threshold values 

The threshold value must be between 1 and 100, depending on the standardized 

representation of the fluorescence curves (dRn). 

Note: The threshold value can be calculated automatically or set in the graph. 

 

 
Opens the selection window with display options  
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Fix Threshold 

4. The threshold value becomes recalculated by the software each time basic settings for the 

analysis are changed. For the analysis the option Fix Threshold can be used, so that the 

threshold value is retained if the basic settings for the analysis are changed (see section 

“Making basic settings“, page 74). 

5.4.3 Displaying the fluorescence curves for the ΔΔCt method 

In the display range, the measured data, standardized to the value 100 for highest fluorescence 

intensity, is plotted against the cycle for the selected target gene. The gene/dye and the reference 

gene/dye combinations are each assigned a list sheet that can be activated by clicking on the 

gene/dye tab on the bottom. 

In the evaluation you can always use only one target gene but several reference genes. The number 

of the available list sheets depends on the number of the selected genes. 

The fluorescence data is displayed as a linear or logarithmic representation depending on the 

selected display option. For both display options the program shows brief information on the sample 

if the cursor is placed on one of the curves. 

Switching the display options for the chart 

1. Click on the  button in the parameter bar. 

A selection window for the display options opens. 

2. Select the Scaling logarithmic or linear option.  

Click next to the selection window. The changes are applied. 

 
Linear representation of the fluorescence curve for the ΔΔCt method 
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Logarithmic representation of the fluorescence curve for the ΔΔCt method 

5.4.4 Display of the normalized relative expression or relative quantities 

After selecting the tab Normalized Expression or Relative Quantity the display changes to a 

presentation of the results as bar chart. The respective sample name is given below each bar. The 

height of the bar is determined by the calculated normalized expression or the calculated relative 

quantity of replicates. For each bar some short information about the position of the samples, the 

mean value and the calculated standard deviation is shown if the mouse pointer is placed on it. 

The size of the standard deviation is shown as error bar on top of each bar. For the representation 

of the relative quantities the results for the target gen and reference gene the bars are colored 

differently. Since for large numbers of samples not all bars can be displayed in the screen the 

diagram can be moved horizontally with pressed left mouse button and dragged to the desired 

position. 

 
Bar chart for display of normalized expression of replicates 
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Bar chart for display of relative quantities of replicates 

5.4.5 Setting the calculation mode for the standardized expression 

The QIAquant 96 Software enables you to calculate the standardized expression SE with two 

different methods: 

 Without PCR efficiency calculation (Livak method) 

 With PCR efficiency calculation for GOI and reference genes (Pfaffl method) 

To calculate the standardized expression SE, one sample must be defined as the calibrator. 

Calculating the standardized expression SE without efficiency calculation (Livak method) 

The Livak method assumes that the PCR efficiencies of the gene of interest (GOI) and the reference 

gene (RefG) are equal. The following applies: 

𝑁𝑁𝑁𝑁 = 2−∆∆𝐶𝐶𝐶𝐶 

where  ∆∆𝐶𝐶𝐶𝐶 =  ∆𝐶𝐶𝐶𝐶(𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶) −  ∆𝐶𝐶𝐶𝐶(𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆) 

and ∆𝐶𝐶𝐶𝐶(𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆) =  𝐶𝐶𝐶𝐶(𝐺𝐺𝐺𝐺𝐺𝐺, 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆) −  𝐶𝐶𝐶𝐶(𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅,𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆) 

 ∆𝐶𝐶𝐶𝐶(𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶) =  𝐶𝐶𝐶𝐶(𝐺𝐺𝐺𝐺𝐺𝐺,𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶) −  𝐶𝐶𝐶𝐶(𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅,𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶) 
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Calculating the standardized expression SE with efficiency calculation (Pfaffl method) 

The Pfaffl method considers the efficiencies determined for the gene of interest (GOI) and the 

reference gene (RefGene). The efficiencies (E(GOI) and E(RefGene)) can be calculated from dilution 

series or specified in the software. The following applies: 

𝑁𝑁𝑁𝑁 =  
1 + 𝐸𝐸(𝐺𝐺𝐺𝐺𝐺𝐺)∆𝐶𝐶𝐶𝐶(𝐺𝐺𝐺𝐺𝐺𝐺)

1 + 𝐸𝐸(𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅)∆𝐶𝐶𝐶𝐶(𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅) 

where   ∆𝐶𝐶𝐶𝐶(𝐺𝐺𝐺𝐺𝐺𝐺) =  𝐶𝐶𝐶𝐶(𝐺𝐺𝐺𝐺𝐺𝐺,𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶)−  𝐶𝐶𝐶𝐶(𝐺𝐺𝐺𝐺𝐺𝐺, 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆) 

and ∆𝐶𝐶𝐶𝐶(𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅) =  𝐶𝐶𝐶𝐶(𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅,𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶) −  𝐶𝐶𝐶𝐶(𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅, 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆) 

The Pfaffl method is generally preferred as the basic assumption of the Livak method (equal 

efficiency when amplifying the gene of interest and the reference gene) is rarely the case in practice 

and the calculation can therefore lead to incorrect values. 

The calculation method is selected in the ddCt Options window. 

 Click on the  symbol in the toolbar. 

Alternatively, call up the DeltaDeltaCt > ddCt Quant. options menu command. 

 Select the desired calculation method.  

For the Pfaffl method, the efficiency values can be determined automatically from the standard 

curves (dilution series) for the gene of interest and the reference gene (if standards have been 

defined) or the values can be entered manually in the respective fields. 
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ddCt Options window for presetting the analysis of the ΔΔCt method 

5.4.6 Displaying the validation curves and values 

To calculate the ∆∆Ct values there is no need to determine a validation curve. However, it might be 

useful to consult it when checking the data quality. Prerequisite for creating a validation curve is 

measuring a standard series with different dilution levels of target gene and reference gene. If 

standard series have been measured for the target and reference gene, the expression ratio 

between target and reference gene is represented graphically in the Validation curve display. For 

this purpose, the mean Ct value of the target gene is subtracted from the mean Ct value of the 

reference gene for the corresponding dilution level and the resulting dCt(V) value is plotted against 

the logarithm of the concentration.  

In the value range on the right the following calculated data is displayed: 

 The coefficient of determination R2 

 The gradient of the validation straight line 

 the intersection of the curve with the y-axis at x=0 (offset) 
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The gradient of the curve should not exceed a value of ±0.1. The assumption then applies that the 

efficiencies of the amplification of the gene of interest and the reference gene are almost identical 

and the calculation of the ΔΔCt values produces valid data.  

 

You can switch between the ΔΔCt calculation views using the Table, Standard curve and Validation 

tabs. The validation curves and the values are automatically calculated by the QIAquant 96 

Software and updated if the settings change. For both, validation curves as well as standard curves 

the respective data points errors bar are shown that indicate the standard deviation between 

replicates. For each data point some short information about the sample name and the mean Ct 

value of replicates is shown if the mouse pointer is placed on it.  

When more than one standard curve is displayed each curve has its individual color. Accordingly 

each table has a color code in the header that reflects the assignment to the respective standard 

curve. 

 
Validation curves view for the ΔΔCt method 
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Result table view for the ΔΔCt method 

For the ΔΔCt-quantification the results table contains the following information: 

 

 Column Meaning  

Well Position of sample* 

Color of curve Each sample is automatically assigned an unchangeable color which is used to display the 
corresponding fluorescence curve 

Sample name Name of sample* 

Sample type Type of sample* 

Group Assignment of the sample to an experimental group*  

GOI Gene of interest  

Reference gene Reference gene  

Ct GOI Ct value of gene of interest  

Ct Ref.gene Ct value of reference gene  

Mean Ct GOI Mean Ct value of replicates of the gene of interest  

Mean Ct Ref.gene Mean Ct value of replicates of the reference gene  

Std.Dev. Ct GOI Standard deviation of the Ct values between replicates of the gene of interest  

Std.Dev. Ct Ref.gene Standard deviation of the Ct values between replicates of the reference gene  

%CV Ct GOI Variation coefficient of the Ct values between replicates of the gene of interest  

%CV Ct Ref.gene Variation coefficient of the Ct values between replicates of the reference gene  

dCt GOI Delta Ct value for replicates of the gene of interest   

dCt Ref.gene Delta Ct value for replicates of the reference gene   

RQ GOI Calculated relative amount for replicates of the gene of interest in the original sample  

RQ Ref.gene Calculated relative amount for replicates of the reference gene in the original sample  

Mean RQ Ref.gene Average calculated relative amount for replicates of the reference gene in the original sample  

Norm. Expression  Standardized relative (x-fold) expression level of the gene of interest in the sample in relation to 
the calibrator 
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Display in the project explorer 

A shortened representation of the validation curves calculated by the software is displayed in the 

project explorer under DeltaDeltaCt. The image displays the graphical plot of the dCt(V) values 

against the logarithm of the sample concentration: 

 

5.4.7 Deleting a ΔΔCt method evaluation 

An evaluation that is no longer required can be removed. 

1. Activate the evaluation by selecting its description in the evaluation list of the method tab. 

2. Click on the  symbol in the toolbar. 

Optionally, call up the DeltaDeltaCt > Delete ddCt quantification menu command. 

The evaluation is removed.  

5.5 Melting curve analysis 

When performing a melting curve analysis the temperature in the reaction mixture is increased 

successively until the PCR product is denatured. The dissociation of the fragment in single strands 

will result in the release of a intercalating dye. The associated reduction of the fluorescence intensity 

is measured and recorded by the device. By forming the first derivative of the fluorescence curve 

you will get a peak that describes the melting point and the approximate concentration of the PCR 

fragment. By means of melting curve analysis you can differentiate whether the reaction has caused 

the formation of a specific PCR product or whether unspecific by-products, such as primer-dimers, 

were produced.  

5.5.1 Creating a new melting curve analysis 

1. Go to the Analysis > Melt. curve project tab. 

If the tab is not visible, click on the arrows  in the tab bar. This will scroll the tabs. 
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2. Click on the  symbol in the toolbar. 

Optionally, call up the Melting curve > Add melting curvemenu command. 

3. An input window appears. Enter the description for the current evaluation. 

On the MeltCurve tab the following information is activated: 

 Parameter settings (1) 

 Display of the fluorescence values as a function of the temperature and/or its first derivative 

(2) 

 Display of the result table (3) 

 

5.5.2 Parameter settings for melting curve analysis 
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Set the following parameters for the melting curve quantification: 

Setting the threshold value 

For the correct evaluation a threshold value must be determined for the melting curves.  

You have several options for setting the threshold value: 

 In the general options (see section “Making basic settings“, page 74) 

 Manually in the parameters for the respective evaluation (see table above) 

 Graphically in the representation of the fluorescence curves derivative: 

In the chart Derivative, move the black threshold line up or down with the cursor. Press and 

hold the left mouse button while doing so. At the same time, the Tm values in the result table 

are updated. 

 Automatic calculation: 

The automatic calculation of the threshold value is activated by clicking on the  symbol. 

Optionally, you can call up the Melting curve/Autom. Threshold menu command. 

Whether you choose manual or automatic calculation, the resulting threshold value is updated and 

displayed synchronously in the corresponding Threshold input field. 

Fix Threshold 

The threshold value becomes recalculated by the software each time basic settings for the analysis 

are changed. For the analysis the option Fix Threshold can be used, so that the threshold value is 

 Option Description  

Selection list Selection of a selection created for the experiment 

Gene of interest 
(GOI) 

Selection list of target gene/dye combinations 

Generally, an intercalating dye must be selected for the target gene for the melting curve 
analysis. 

According to the selection, the fluorescence and regression curves for the concentration are 
displayed. 

Group If several experiments were carried out on the PCR plate, select the group of the experiment to be 
analyzed (see section “Defining groups”, page 55). 

Threshold Manually adjust threshold values 

The threshold is now effective on the Derivative tab. Only curves whose maximum dRn/dT is 
greater than the threshold are analyzed. 

Note: 
The threshold value can be calculated automatically or set manually in the chart (see also 
“Setting the threshold value” below). 

 Opens the selection window with display options  
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retained if the basic settings for the analysis are changed (see section “Making basic settings“, 

page 74). 

5.5.3 Displaying fluorescence curves/melting curves 

In the display area, the measured fluorescence curves are shown in relation to the temperature and 

are either standardized to the highest fluorescence value or both standardized to a target value of 

100, depending on the settings made in the Melt. Curve Options window. The data is displayed as 

a linear or logarithmic representation depending on the selected display option.  

 

The program shows brief information on the sample if the cursor is placed on one of the curves.  

The melting temperature Tm is determined by forming the first derivative of the melting curves from 

the maxima of the forming peaks. To evaluate fluorescence data from protein stability 



 

 
 

QIAquant™ 96 Software User Manual   07/2021 110 

measurements, the melting curves can be reversed. The reversal of the melting curves can be 

activated via the flip curve option. 

 

You can switch between the melting curves display and the derivatives via the tab in the bottom left 

corner of the display range.  

Switching the display options for the chart of fluorescence curves 

1. Click on the  button in the parameter bar. 

A selection window for the display options opens. 

2. Select the Scaling logarithmic or linear option. 

Click next to the selection window. The changes are applied. 

The Derivative tab cannot be displayed logarithmically. 

 

The linear display does not show a threshold line. 
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5.5.4 Display of melting temperatures 

After selecting the tab Tm the display changes to a presentation of the results as bar chart. The 

respective sample name is given below each bar. The height of the bar is determined by the 

measured melting temperature of replicates. For each bar some short information about the position 

of the samples, the mean value and the calculated standard deviation is shown if the mouse pointer 

is placed on it. The size of the standard deviation is shown as error bar on top of each bar. Since 

for large numbers of samples not all bars can be displayed in the screen the diagram can be moved 

horizontally with pressed left mouse button and dragged to the desired position. 

 

5.5.5 Displaying the result table for the melting curves 

The result table for melting curves contains all data and the associated measurement values for the 

samples.  
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For melting curves the results table contains the following information: 

Display in the project explorer 

A shortened representation of the melting curves calculated by the software is displayed in the 

project explorer under “Melt Curve”. This representation shows the graphical plot of the first 

derivative of the fluorescence values against the temperature. 

 

5.5.6 Deleting a melting curve analysis 

A melting curve analysis that is no longer required can be removed. 

1. Activate the evaluation by selecting its description in the evaluation list of the method tab. 

2. Click on the  symbol in the toolbar. 

Alternatively, call up the Melting curve > Delete melting curve menu command. 

The evaluation is removed.  

 Column Meaning  

Well Position of sample 

Color of curve Each sample is automatically assigned an unchangeable color which is used to display the 
corresponding fluorescence curve 

Sample name Name of sample 

Sample type Type of sample 

Group Assignment of the sample to an experimental group  

Gen e Name of gene measured in the sample  

Tm Melting temperature of the sample  

Mean Tm Mean melting temperature of replicates  

Std Dev Mean Tm Standard deviation of mean melting temperature of replicates  
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5.6 Genotyping 

Genotyping serves to determine sequence differences between a sample and a standard. The 

standard is defined as the reference sequence (genotype 1); the genetic condition of the sample is 

to be determined in the experiment. Genotyping shows which alleles an individual has inherited 

from its parents. 

5.6.1 Creating a new evaluation for genotyping 

1. Go to the Analysis/Genotyping project tab. 

If the tab is not visible, click on the arrows  in the tab bar. This will scroll the tabs. 

2. Click on the  symbol in the toolbar. 

Alternatively, call up the Genotyping/Add genotyping menu command. 

3. Enter the description for the current evaluation in the input window. 

The following information is activated on the Genotyping tab: 

 Parameter setting for defining the threshold and selecting the dye with which the wild type 

and the mutant were measured (1) 

 Display of the fluorescence curves of wild type and mutant and/or display of the results as a 

scatter plot or bar graph (2) 

 Display of the result table with the results (3) 
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Genotyping window 

5.6.2 Parameter settings for genotyping 

 
Parameter settings for genotyping for the fluorescence curve display 
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Set the following parameters for the absolute quantification: 

When changing to the scatter plot or end point bar graph, two fields are displayed for the CutOff 

value for the Genotype 1 and the Genotype 2 instead of the Threshold field: 

 

Setting the threshold value 

To determine Ct values for the evaluation a threshold value must be determined for each experiment.  

You have several options for setting the threshold value: 

 In the general options (see section “Making basic settings“, page 74) 

 Manually in the parameters for the respective evaluation (see table above) 

 Graphically in the fluorescence curves representation: 

In the chart, move the black threshold line up or down with the cursor. Press and hold the left 

mouse button while doing so. At the same time, the Ct values in the result table are updated. 

Note: The logarithmic view is more suitable for placing the threshold manually in the display 

area than the linear view because of the wider spread of the early exponential area of the 

product accumulation curves. 

 Option Description  

Selection list Selection of an evaluation created for the experiment 

Genotype 1 Selection list for the dye with which the genotype 1 was measured. 

Genotype 2 Selection list for the dye with which the genotype 2 was measured. 

Include passive 
reference 

Only active if a dye has been defined as a passive reference on the Settings/Scan project tab. 

If this option is activated, the fluorescence of the dye that has been set as a passive reference is 
used for standardization. 

Group If several experiments were carried out on the PCR plate, select the group of the experiment to be 
analyzed (see section “Defining groups”, page 55). 

 

Threshold Manually adjust threshold value. 

The threshold value must be between 1 and 100, depending on the standardized representation 
of the fluorescence curves (dRn). 

Note: The threshold value can be calculated automatically or set manually in the chart (see see 
also “Setting the threshold value” below). 

 

 Opens the selection window with display options (see section “Displaying the fluorescence 
curves for absolute quantification“ S. 82). 
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 By having it calculated automatically: 

To activate the automatic calculation of the threshold value, click on the  symbol. 

Alternatively, you can call up the Genotyping/Autom. threshold menu command. 

Whether you choose manual or automatic calculation, the resulting threshold value is updated and 

displayed synchronously in the Threshold input field. 

Fix Threshold 

The threshold value becomes recalculated by the software each time basic settings for the analysis 

are changed. For the analysis the option Fix Threshold can be used, so that the threshold value is 

retained if the basic settings for the analysis are changed (see section “Making basic settings“, 

page 74). 

5.6.3 Specifying genotyping options 

Special evaluation options are available for genotyping. 

 Click on  in the toolbar to open the Genotyping Options window. 

 Alternatively, you can call up the Genotyping/Genotyping Options menu command. 
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5.6.4 Displaying the fluorescence curves, scatter plot and bar graph 

The respective combination of genotype 1 dye or genotype 2 dye displayed is shown on the tabs 

in the bottom left corner of the area. The entry for the respective active combination on the tab is 

highlighted in white. The fluorescence data is displayed as a linear or logarithmic representation 

depending on the selected display option. For both view types a brief information is shown as soon 

as the mouse pointer is positioned on one of the curves. 

1. Click on the  button in the parameter bar. 

A selection window for the display options opens. 

2. Select the Scaling logarithmic or linear option.  

Click next to the selection window. The changes are applied. 

 
Linear representation of the fluorescence curve for genotyping 

 Option Description  

Cycle of interest Select the cycle for evaluation. This can preferably be the last cycle (end point) but also any other 
cycle of the PCR run. The respective cycle can be selected from a list. 

Descriptions Input fields for own names for the genotype1, genotype 2, heterozygote categories or otherwise 

Scatter Plot Generation of the scatter plot based on the fluorescence intensities of the analyzed cycle and/or 
the Ct values 
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Logarithmic representation of the fluorescence curve with horizontal threshold line 

To determine Ct values for the analysis a threshold value must be determined for the fluorescence 

curves. This can be automated but is also possible manually in the display area (see section 

“Parameter settings for genotyping“, page 114). 

In addition to the fluorescence curves representation, the results can also be displayed as a scatter 

plot or bar graph. This can be selected via the respective tabs below the display area. 

 

The scatter plot is divided into 4 quadrants for genotype1, genotype 2, heterozygote and error. 

The samples are assigned to one of the quadrants based on the measured relative fluorescence or 

the Ct values of the two dyes. The respective cutoff value for the sample assignment is represented 

by two black lines in the scatter plot view. To change the position of the lines and thus change the 

cutoff value, select the lines and keep the left mouse button pressed. Alternatively, the respective 

cutoff value for genotype 1 and genotype 2 can also be entered in the respective fields in the 

selection area (see “Parameter settings for genotyping“, page 114). 
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The bar graph shows the measured relative fluorescences as bars. The x-axis is scaled from A to H 

based on the rows of the block, i.e., the first twelve samples correspond to positions A1 to A12 in 

the block, the next twelve samples correspond to positions B1 to B12 etc. The cutoff value is set by 

moving the red or blue horizontal line up or down with the left mouse button pressed. Alternatively, 

the respective cutoff value for mutant and wild type can also be entered in the respective fields in 

the selection area of this view (see “Parameter settings for genotyping“, page 114). 

The cutoff values are thresholds after which the question whether a sample shows a reaction is 

answered with “Yes” (see Reaction genotype 1 and Reaction genotype 2 table columns). 

5.6.5 Display of the values for the genotyping evaluation 

The result table for the genotyping combines all data and corresponding measurements for the 

samples. The columns shown in the result table differ depending on the tab selected in the display 

area. The table for the fluorescence curves provides a summary which includes the measuring data 

of both dyes. If the fluorescence intensity at the end point is evaluated, the result table for the scatter 

plot is the same as the one for the bar graph. The data summarized in the result table for the 

fluorescence curves, however, partly differ from the data in the scatter plot or bar graph evaluation.  

 

For the genotyping the results table contains the following information: 
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Individual columns can be shown or hidden by selection or deselection. The layout of the columns 

can also be freely modified. By dragging a column heading with the left mouse button depressed 

columns can be swapped. The display of the results in the table can thus be adjusted as desired. 

Display in the project explorer 

Optional the scatter plot or the end-point analysis calculated by the software can be displayed in 

short form in the project explorer under the point Genotyping. The scatter plot is divided into for 

quadrants for mutant, heterozygous, wild-type and error. The samples are assigned to a quadrant 

by the relative fluorescence or the Ct values determined for both fluorescent dyes. For the end-point 

 Column Meaning  

Well Position of sample* 

Color of curve Each sample is automatically assigned an unchangeable color which is used to display the 
corresponding fluorescence curve 

Sample name Name of sample* 

Sample type Type of sample* 

Group Assignment of the sample to an experimental group*  

Ct Genotype 1 Ct value of genotype 1   

Mean Ct Genotype 1 Mean Ct value of replicates of the genotype 1  

Std.Dev. Ct Genotype 1 Standard deviation of the Ct values between replicates of the genotype 1  

Ct Genotype 2 Ct value of genotype 2  

Mean Ct Genotype 2 Mean Ct value of replicates of the genotype 2  

Std.Dev. Ct Genotype 2 Standard deviation of the Ct values between replicates of the genotype 2  

Genotype Assign the sample according to genotype 1, genotype 2, heterozygote or error  

Reaction Genotype 1 Yes or no, depending on the end point fluorescence or Ct value  

Reaction Genotype 2 Yes or no, depending on the end point fluorescence or Ct value  

Genotype Replicates Assign replicates according to genotype 1, genotype 2, heterozygote or error (“?” symbol)  

dRn Genotype 1 Standardized fluorescence intensity of the genotype 1reaction  

Mean dRn Genotype 1 Standardized fluorescence intensity between replicates of the genotype 1 reaction  

Std.Dev. dRn Genotype 1 Standard deviation of the standardized fluorescence intensity between replicates of the 
genotype 1reaction 

 

dRn Genotype 2 Standardized fluorescence intensity of the genotype 2reaction  

Mean dRn Genotype 2 Standardized fluorescence intensity between replicates of the genotype 2reaction  

Std.Dev. dRn Genotype 2 Standard deviation of the standardized fluorescence intensity between replicates of the 
genotype 2reaction 
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analysis the measured relative fluorescence is plotted as bar chart. Die height of the bars defines 

the samples as genotype 1, genotype 2, heterozygous or error. 

 
Representation of results for genotyping as scatter plot. 

 
Representation of results for genotyping as bar chart. 

5.6.6 Deleting a genotyping 

An evaluation that is no longer required can be removed. 

1. Activate the evaluation by selecting its name in the evaluation list of the method tab. 

2. Click on  in the toolbar. 

Alternatively, call up the Genotyping > Delete Genotyping menu command. 

The evaluation is removed.  

5.7 POS/NEG analysis at the end point 

Positive/negative analysis at the end point of a qPCR is used to decide, whether or not a target 

gene is present in the reaction mix. Such an analysis can be configured as singleplex or multiplex 

experiment using fluorescence data at the end point of a PCR run, i.e., after amplification is finished. 

The position of the end point – with respect to the cycle number – as well as the cycles to be included 

can be set by you. Using the NTC samples a cutoff value is calculated which discerns positive and 
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negative for each individual sample. The software also accounts for internal positive controls (IPC) 

which can be added to each sample in order to avoid false negative results thus increasing the 

confidence level of the experiment. 

5.7.1 Starting end point analysis 

1. Go to the Analysis/Endpoint project tab. If it is not visible, click on the arrows in the tab bar. 

This will scroll the tabs. 

2. Click the symbol  in the toolbar. Alternatively you can select the menu Endpoint/Add 

Endpoint. 

3. An input window appears. Enter the description of the current evaluation. 

Note: An end point analysis can only be opened if the plate layout contains at least one NTC-

sample (see section “Editing the sample table”, page 42). 

On the Endpoint tab the following information is activated: 

 Edit fields for parameter settings 

 Amplification curves of the selected GOI and the internal positive control IPC in a combined 

diagram. 

 Amplification curves of the selected GOI and the internal positive control IPC in separate 

diagrams which allow for setting the cutoff. 

 Display of results in a PCR plate scheme 

 Display of results in a bar chart 

 Results table with measurement data and classification of the unknown samples as POS, NEG, 

??? , CHECK 
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Window for end point anaylis 

5.7.2 Parameters settings for endpoint analysis 

 

1. Set the following parameters for endpoint analysis: 

 Option Meaning  

Shortlist Selection of an evaluation created for this experiment 

Gene of Interest (GOI) Selection list of the gene/dye combination of interest 

Internal Positive 
Control (IPC) 

Selection of the gene/dye combination which is used for IPC 

Group If several experiments were carried out on the plate, select of experiments to be analyzed. 

Cutoff Cutoff defines the fluorescence value above which the sample is considered to be positive  
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2. Define the cycle numbers which shall be considered as endpoint.  

By default the mean fluorescence of the last two cycles is taken for calculations. You can 

define more than 2 cycles at the end or an interval of cycles of the qPCR run as source of 

endpoint fluorescence data.  

The selected cycles are highlighted in the chart by a yellowish bar. 

  

 

  
Last 2 cycles selected   Cycles 35 to 37 selected 

Setting Cutoff values 

Cutoff-values for GOI and IPC can be set manually or calculated automatically. You can select 

different methods for automatic calculation in the options dialogue    for endpoint analysis. 

Manual methods 

 Enter a number for Cutoff directly in the edit field Cutoff or in the options dialogue 

 Shift the Cutoff line using the mouse in the tabs GOI and IPC 

Automated methods 

 With negative control or NTC:  

The Cutoff-value is calculated from the mean fluorescence of the NTC samples plus the fraction 

(given in percent) from the difference between maximal sample fluorescence and mean 

fluorescence of the NTC samples. Fluorescence data is taken from the specified end point 

cycles.  

 With internal positive control IPC and NTC:  

Cutoff values for NTC and IPC are calculated separately. The standard deviation of the 

fluorescence of all NTC samples (or IPC- samples, i.e., samples which do not contain an 
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internal positive control) is multiplied with a factor T which is read from a table and is 

dependent from the desired confidence interval and the number of samples.  

 You can start the automatic calculation of Cutoffs according to the settings in the options by 

clicking  . Alternatively you can choose the command Endpoint/Auto Threshold CutOff 

from the menu.  

Note: If the plate layout does not contain samples which are labeled as IPC- , the option „with 

internal positive control and NTC” will not be available. On the tab Settings/Samples selected wells 

can be labeled as IPC- by right clicking the highlighted wells and select Assign IPC- from the context 

menu (see section “Editing the sample table”, page 42). 

5.7.3 Displaying results in end point analysis 

The results of the analysis (POS, NEG, ???, CHECK) are evaluated according to the following rules: 

Without IPC 

With IPC 

Evaluation of replicates 

Samples which are present in replicates (having the same sample name) are considered to be POS 

or NEG if all replicates of that sample are POS or NEG. If this is not the case CHECK will be 

displayed. It is possible to manually deselect samples in the project explorer which are recognized 

as outliers. 

 Fluoescence of a single GOI sample Result  

>Cutoff (GOI) POS (positive) 

≤Cutoff (GOI) NEG (negative) 

 

 Fluorescence of a single GOI sample Fluorescence of a single IPC sample Result  

>Cutoff (GOI) >Cutoff (IPC) POS (positive) 

≤Cutoff (GOI) >Cutoff (IPC) NEG (negative) 

>Cutoff (GOI) ≤Cutoff (IPC) ??? (problematic)  

≤Cutoff (GOI) ≤Cutoff (IPC) ??? (problematic)  
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After creation of a new analysis or after having changed options or cutoff values the results are re-

calculated and charts and table will be refreshed. 

Results table 

 

For the end point the results table contains the following information: 

 Fluorescence of replicates Result of sample  

all POS POS (positive) 

all NEG NEG (negative) 

otherwise CHECK (eliminate outliers or repeat sample)  
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The results table displays all calculated numerical data and the evaluation of single samples and 

replicates. You can design the results table according to your requirements by setting type, sequence 

and width of the columns to be displayed. You can also adjust the sort sequence of data in the 

column (alphabetical, numerical, by column, by row). The table configured this way can be 

exported as Excel or CSV file by right clicking the table. 

 

 Column Meaning  

Well Position of sample 

Color of curve Each sample is automatically assigned an unchangeable color which is used to display the 
corresponding fluorescence curve 

Sample name Name of sample 

Sample type Type of sample* 

FluoGOI Fluorescence of the GOI samples at the endpoint  

Mean FluoGOI Mean fluorescence of the GOI replicates at the endpoint  

Std.Dev. FluoGOI Standard deviation of the GOI replicates at the endpoint  

FluoIPC Fluorescence of the IPC samples at the endpoint  

Mean FluoIPC Mean fluorescence of the IPC replicates at the endpoint  

Std.Dev.FluoIPC Standard deviation of the IPC replicates at the endpoint  

Status GOI POS if FluoGOI > CutOff, else NEG (for each sample well)  

Status IPC POS if FluoIPC > CutOff, else NEG (for each sample well)  

Result sample Rating  POS/NEG/???  for each well  

Result replicates Rating POS/NEG/CHECK of the replicates  
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PCR plate scheme (Grid) 

 

The PCR plate scheme offers a quick overview of the results obtained in each single well. If the 

mouse pointer is moved across a well a hint box is displayed showing the sample name and the 

end point fluorescence of GOI and IPC for that well. You can change the colors which code for 

POS, NEG and ??? in Extras/Options/Colors. 
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Bar Chart 

 

The bar chart displays the end point fluorescence of the GOI together with the IPC as well as the 

corresponding cutoff values as horizontal lines. Red lines denote the GOI and blue ones the IPC. If 

the mouse pointer is moved across a bar a hint box is displayed showing the sample name and the 

end point fluorescence of GOI and IPC for the corresponding well. 

Note:  Cutoff lines cannot be changed in the bar chart. To do so, please switch to the tabs GOI or 

IPC. 
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6 Multigene-/Multiplate-Analysis 

The Multigene-/Multiplate-Analysis is used to analyze real-time PCR data of multiple target genes 

in parallel or to analyze data from multiple project files if, for example, several PCR plates have 

been used for an experiment. The Multigene-/Multiplate-Analysis is executed as dialog in a 

separate window independent of the surface of the QIAquant 96 Software. For the Multigene-

/Multiplate-Analysis project files generated by the QIAquant 96 Software are used. The project 

files must include a ∆∆Ct-analysis for Multigene-/Multiplate-Analysis. 

6.1 Start Multigene-/Multiplate-Analysis 

To start the Multigene-/Multiplate-Analysis click on the button  in the toolbar. A new window 

for Multigene-/Multiplate-Analysis appears. 

6.2 The window for Multigene-/Multiplate-Analysis 

After starting the dialog the window for Multigene-/Multiplate-Analysis opens. It is divided into the 

following sections: 

 Menu bar (1)  The menu bar contains the menu commands for, e.g., opening, editing, saving and printing of 
Multigene-/Multiplate-Analysis files and a help function.  

 

Toolbar (2)  In the toolbar commands for editing Multigene-/Multiplate-Analysis files are arranged. 

Project list (3)  In the project list projects that are used for Multigene-/Multiplate-Analysis are listed and 
administrated.  

Samples (4)  In the layout the measurement data of samples can be selected or unselected. Only data of 
selected samples becomes included to the analysis and is used for the results calculation. 
Furthermore in the layout the position of interplate standards (IPS) can be defined. 

Data display (5)  In the data display amplification curves of imported project files are shown or the results of the 
Multigene-/Multiplate-Analysis are plotted as bar chart.  

Results table (6)  In the results table the imported measurement data of the activated project file or the results of the 
Multigene-/Multiplate-Analysis are shown.  
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Windows Multi gene for Multigene-/Multiplate analysis 

6.3 Overview of menu commands 

In the Multigene-/Multiplate-Analysis window the following commands are available in the File 

menu:  

 

 

  

 Command  Description   

New Multigene-/Multiplate-Analysis Opens a new Multigene-/Multiplate-Analysis 

Open Multigene-/Multiplate-Analysis Opens a Multigene-/Multiplate-Analysis. 

Save Multigene-/Multiplate-Analysis Saves a Multigene-/Multiplate-Analysis in the QIAquant 96 Software 
standard folder 

Save Multigene-/Multiplate-Analysis as Saves a Multigene-/Multiplate-Analysis in any user-selected folder 

Print Multigene-/Multiplate-Analysis Prints the results of a Multigene-/Multiplate-Analysis 

Close  Closes the window for Multigene-/Multiplate-Analysis 
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6.4 Overview of the tools in the toolbar  

6.5 Managing Multigene-/Multiplate-Analysis files 

After clicking on  the Multigene-/Multiplate-Analysis dialog starts in a separate window and 

contains no data. 

6.5.1 Start new Multigene-/Multiplate-Analysis 

To start a new Multigene-/Multiplate-Analysis press on  or call up the File > New menu 

command. An already loaded Multigene-/Multiplate-Analysis will be closed. If the analysis has 

been modified and the changes are not yet saved, a prompt opens. 

Note: Only one Multigene-/Multiplate-Analysis can be opened. 

6.5.2 Open saved Multigene-/Multiplate-Analysis 

1. Click on  or call up the File > Open Multigene-/Multiplate-Analysis menu command.  

2. In the standard window, select the desired file to open and confirm the selection with OK. 

Note: If the file type is linked to the QIAquant 96 Software in Extras > Options the dialog for 

Multigene-/Multiplate-Analysis starts automatically by a double click on the selected file. 

The Multigene-/Multiplate-Analysis including the project list, sample layout, measurement data and 

analysis opens. 

6.5.3 Save Multigene-/Multiplate-Analysis 

The Multigene-/Multiplate-Analysis including all loaded project files and analysis is stored. 

 Button  Command  Function  

 
NEW  Opens a new Multigene-/Multiplate-Analysis 

 
Open Opens a Multigene-/Multiplate-Analysis 

 
Save Saves a Multigene-/Multiplate-Analysis 

 
Print Prints a Multigene-/Multiplate-Analysis 

 
Options Allows the input of efficiencies of PCR reactions for single 

genes of interest 
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1. Select the menu command File > Save Multigene-/Multiplate-Analysis. 

2. To save files enter the name of the template in the standard window and save the template 

with OK. 

Changes in a Multigene-/Multiplate-Analysis can be saved with the File > Save Multigene-

/Multiplate-Analysis menu command. Optionally, you can click on the symbol  in the toolbar. 

6.5.4 Close Multigene-/Multiplate-Analysis 

The File > Close Multigene-/Multiplate-Analysis menu command closes the Multigene-/Multiplate-

Analysis window. If any unsaved changes have been made in analysis, a confirmation prompt 

appears. 

6.5.5 Print Multigene-/Multiplate-Analysis 

The data and results of a Multigene-/Multiplate-Analysis can be printed using the Print 

function. For this purpose, an analysis must be applied and in the data display the tab Analysis 

must be selected (see section “The window for Multigene-/Multiplate-Analysis“, page 130). By 

using the command File > Print Multigene-/Multiplate-Analysis or the icon  in the toolbar the 

print function is started.  

6.6 Load Project Files 

If a new Multigene-/Multiplate-Analysis is started, at first a blank window is displayed. To perform 

an analysis project files have to be loaded. In the project files a ∆∆Ct-analysis must be applied to 

evaluate them by Multigene-/Multiplate-Analysis. 

1. To load a project file click on the button Add project.  

2. In the standard window select one or more stored project files and confirm your selection 

with OK. Loaded projects are listed in the project list. 

 
1. To remove a project file mark the File in the project list. 
2. Click on button Remove project. 

6.7 Activate/Deactivate project files for Multigene-/Multiplate-Analysis 

In the project list, a check box is show next to each loaded project. By the check box projects can 

be activated or deactivated. Only data from activated projects is used for analysis. 
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 The data of deactivated project files remain loaded in the background and after re-activation are 

used for analysis again. 

6.8 Activate/Deactivate samples for Multigene-/Multiplate-Analysis 

In the data display for Multigene-/Multiplate-Analysis activate the tab Projects (see section “The 

window for Multigene-/Multiplate-Analysis“, page 130). On the tab Activate samples of the data 

display samples of single wells can be activated or deactivated for analysis. By deactivation of 

samples outliers are eliminated and not included in the calculation of mean values. 

Note: The sample selection has only influence on the analysis of data, no measurement data is 

deleted. 

  

The sample layout is taken from the loaded project files. The color code for each sample type can 
be modified in menu Extras/Options > Colors. 

Active wells (i.e., displayed wells) are marked with their sample type symbol. For deactivated wells 

the position is grey and the fluorescence data is hidden. Empty wells are marked “E”.  

 Sample type Symbol Definition   

Empty  E  Describes an empty position on the PCR plate 

Unknown  U  Sample of unknown concentration or dilution (measuring sample) 

Stnadard S  Sample of known concentration or dilution 

Calibrator K  Sample whose gene of interest expression level is set as 1 

No Template Control (NTC)  N  Complete reaction preparation but without matrix strand  

Positive Control  +  Positive control preparation for which a reaction product is expected  

Negative control  -  Negative control preparation for which no reaction product is expected  
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 Click with the mouse to switch. The activation changes with each click on a well.  

 You can change adjacent wells by holding the mouse button and moving the cursor over the 

wells. To select non-adjacent positions press the Ctrl key on the keyboard plus the left mouse 

button at each position.  

 Complete rows and columns can be inverted by clicking on the letter or number of the row A–

H or column 1–12.  

 The activation status of the complete plate can be inverted by clicking on on the top left 

between A and 1.  

 To activate all wells click on the symbol  below the chart. 

 To activate only samples of a specific type click on the corresponding symbol below the chart. 

To activate multiple sample types at the same time keep the Ctrl key pressed when clicking on 

the sample types.  

6.9 Define Interplate-Standards for Multigene-/Multiplate-Analysis 

Activate the tab Projects in the data display for Multigene-/Multiplate-Analysis (see section 

“The window for Multigene-/Multiplate-Analysis“, page 130). For the Multigene-/Multiplate-

Analysis Interplate-Standards (IPS) are used on each PCR plate and the deviations among 

themselves are determined and calculated. 

1. To define Interplate-Standards activate the tab Assign IPS in the sample display. 

  

2. Select the position of Interplate-Standards: 

 Press the left mouse button and drag the area that contains the IPS samples: 

Selected samples are displayed in grey against a green background. For not selected 
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samples only the sample type icon is displayed. Empty wells are marked with “E”. To 

select samples see also section “Activate/Deactivate samples for Multigene-/Multiplate-

Analysis“, page 134. 

 If the IPS position is the same on all plates the current selection is transferred to all loaded 

projects by activating the checkbox IPS on identical positions. 

 Click on the button Delete IPS to delete the IPS in all loaded projects. 

6.10 Set threshold and PCR-efficiencies for Multigene-/Multiplate-
Analysis 

After loading project files the measurement data for the active project is shown in the display area. 

The active project is marked blue in the project list on the left. By clicking on the name in the project 

list another project can be activated and thus switched between different projects. 

 

 
For the active project the fluorescence curves and results are shown under the tab “Projects” 

From the loaded projects all measurement results and settings are taken. In the dialog for Multigene-

/Multiplate-Analysis most settings cannot be modified, this is only possible in the individual projects 

in the QIAquant 96 Software. 
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Edit threshold 

On the tab Projects the threshold for each dye can be adapted. 

1. Activate the relevant project in the project list. 

2. Select a dye from the list on the tab Projects. 

  

3. If in the project file different groups are defined select the right group from the list. 

  

4. To modify the threshold value two different options are available: 

 In the chart, move the black threshold line up or down with the cursor. Press and hold the left 

mouse button while doing so. 

 Enter a value in the field Threshold. 

With the modification of the threshold the values in the result table displayed below are updated.  

Edit PCR efficiency 

Basically, PCR efficiencies are taken from the loaded project files but it is possible to set adjust the 

value for the considered genes. 

1. Activate the tab Analysis in the data display and click the button  in the toolbar. 

2. Adjust for each gene the PCR efficiency in the window Options. 
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3. Enter a new value and confirm with OK. 

6.11 Evaluation of the Multigene-/Multiplate-Analysis 

The results of the Multigene-/Multiplate-Analysis are summarized under the tab Analysis of the data 

display. 

 
Results of the Multigene-/Multiplate-Analysis 
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The data display is divided into the following sections: 

 Parameter settings (1) 

 Graphical data display (2) 

 Results table with measured values (3) 

Parameter settings for Multigene-/Multiplate-Analysis 

 

 

Table 2.  

Results display for Multigene-/Multiplate-Analysis 

The results of the Multigene-/Multiplate-Analysis are shown as bar charts. In the tab Normalized 

Expression the expression of selected genes of interest, normalized to the expression of the reference 

genes, is shown. In the second tab Relative Quantity the corresponding quantity for the genes of 

interest and reference genes is displayed. The respective sample name is given below each bar. 

The height of the bar is determined by the calculated normalized expression of replicates. For each 

bar some short information about the sample name, mean value and the calculated standard 

deviation is shown if the mouse pointer is placed on it. The standard deviation for the normalized 

expression is shown as error bar on top of each bar. Since for larger numbers of samples not all 

can be displayed in the screen the diagram can be moved horizontally with pressed left mouse 

button and dragged to the desired position. Using the mouse wheel allows to narrow or broaden 

the width of the representation. Alternatively the cursor keys ↑ and ↓ can be used.  

 Option  Description   

Genes of Interest (GOI)  Selection list of target gene/dye-combinations. Multiple target genes can be selected. 

The symbol  is used to remove all target genes from the evaluation  

Reference genes  Selection list of reference gene/dye-combinations. Multiple reference genes can be 

selected. 

The symbol  is used to remove all reference genes from the evaluation. 

Scaling Y Selection of the scaling of the Y-axis. 

Interplate calibration With activated interplate calibration from the selected IPS samples of all plates a 
correction factor is determined* and from the mean Ct values of replicates the corrected 
mean Ct values are calculated (see results table). The corrected mean Ct values are then 
used to calculate the relative quantity and the normalized expression. Is the interplate 
calibration deactivated, the corrected mean ct values are equal to the mean ct values. 
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By a right-click on the chart the results are sorted by genes or samples names on the x-axis. 

  
Representation of the normalized expression as bar chart sorted by sample name. 

  
Representation of the normalized expression as bar chart sorted by gene name. 

 

 
Representation of the relative quantity as bar chart sorted by sample name. 
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Representation of the relative quantity as bar chart sorted by gene name. 

In the tab Table of the results table for Multigene-/Multiplate-Analysis all data and measurement 

values for the samples are summarized. 

 

 

For the Multigene-/Multiplate-Analysis the results table contains the following information:  

You can design the results table according to your requirements by setting type, sequence and 

width of the columns to be displayed. You can also adjust the sort sequence of data in the column 

 Column Meaning  

Project name  Name of the loaded project that contains the sample 

Gene Name of the investigated gene 

Sample NAME  Name oft he sample  

No of replicates Number of replicates of the sample 

Mean Ct Mean Ct-value of the replicates of a sample  

Mean Calib. Ct Mean Ct-values of replicates of a sample calibrated by the IPS  

Std. Dev. Mean Calib. Ct Standard deviation of the mean calibrated Ct-values of replicates of a sample  

RQ  Calculated relative quantity for replicates of the gen in the original sample  

Std. Dev. RQ  Standard deviation of the calculated relative quantity for replicates of the gen in the 
original sample 

 

Norm. Exp. Normalized expression of the sample  

Std. Dev. Norm. Exp.  Standard deviation of the normalized expression of the sample  
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(alphabetical, numerical, by column, by row). The table configured this way can be exported as 

Excel or CSV file by right clicking the table. 

 

In the tab IPS of the results table for Multigene-/Multiplate-Analysis all data for the Interplate 

Standards (IPS) is summarized. 

  

Table 3.  

 

 Column Meaning  

Project name  Name of the loaded project that contains the IPS sample 

Dye Dye that has been used to determine the Ct value of the IPS sample 

Mean Ct (IPS, Project) Mean Ct value of IPS samples in the project (dependent upon the used dye) 

Mean Ct (IPS, all Projects) Mean Ct value of IPS samples in all projects (dependent upon the used dye) 

Correction value Ct correction value that is applied for all samples of the project (column 1) and the dye 

(column 2) 
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7 MIQE documentation 

In 2009 an international group of experts led by Prof. Steven Bustin developed guidelines for the 

publication of real-time PCR data (Bustin et al. 2009, Clinical Chemistry 55:4, 611-622). The aim 

was to prevent the publication of incomplete or incorrect real-time PCR data and to ensure 

comparability and reproducibility of experiments. The guidelines regulate the requirements 

regarding the minimum information necessary for the publication of data and have become known 

as MIQE (Minimum Information for Publication of Quantitative Real-Time PCR Experiments). 

Instructions for completing the MIQE documentation 

1. MIQE consists of a list of questions to 9 different topics about real-time PCR experiments. In 

the QIAquant 96 Software under the tab MIQE buttons for each topic buttons are present 

providing access to the corresponding list of questions. Additionally the button MIQE-Home 

allows to jump back to the main menu from any sub menu. 

2. In general at first by activating the corresponding radio button in the main screen it should be 

defined is DNA or RNA has been used as starting material. If the option DNA is activated 

the questions for topic Reverse Transcription do not have to be answered and the 

corresponding button becomes inactive. 

3. After clicking on a button the corresponding questionnaire opens. The number of questions 

differs between the topics. The user should answer as much questions as possible.. 

4. The answer to some questions is taken from the currently opened project and active project if 

the relevant information is available. 

5. The completeness of the answers to the questions is presented by the software as progress 

bar and measured in %. The MIQE questionnaire distinguishes between essential questions 

that should be answered and additional optional questions that can be answered. The entry 

fields for essential questions are highlighted by a red colored background whereas 

additional questions have a white colored background. For the progress bar only the 

answered essential questions are ranked by the software. The total number of questions 

differs depending on whether DNA or RNA has been used as starting material. The software 

cannot evaluate the quality of the answers. It is up to user to fully answer the questions and 

with due diligence. 

6. The QIAquant 96 Software offers to import MIQE data from other projects. Clicking on the 

button  in the toolbar or by using the menu item MIQE/Import MIQE Documentation opens 

a dialog screen. After selecting the appropriate project the saved MIQE data is imported into 

the current project. 
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7. The questionnaire can be printed by the Print function of the QIAquant 96 Software. Select 

the point MIQE under Documentation (see section Printing, page 23 and press Print. It is 

always the complete questionnaire printed. 
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8 Functions in Extras menu 

8.1 Device initialization 

The device initialization sets the device to the original state. A device initialization is only required 

after an error has occurred. 

 Call up the Extras > Device initialization command. 

  Connecting the device to the PC 

The software QIAquant 96 Software automatically recognizes which instrument is connected and 

whether it is switched on or not. The instrument may also be switched on and off during running 

QIAquant 96 Software. Whether an active connection is established will be indicated in the lower 

left corner of the status line. 

 If a connection cannot be obtained in between 30 seconds you can use the Extras > Device 

identification in order to solve the problem. 

8.2 General settings in the QIAquant 96 Software 

General settings for the QIAquant 96 Software program can be made in the Options window. 

Note: For most of the settings in the Options window you need to be logged into QIAquant 96 
Software as an administrator. 

1. Close all projects. 

2. Select the Extras > Options menu command to open the window of the same name. 

3. Make the following settings on the tabs: 
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 Tab Function  

General Define that the last measurement results are saved automatically (see section “Opening an 

automatically saved project”, page 20) 

Define the saving mode of projects and their file names (see section “Saving a project”, 
page 21). 

Data format Select decimal separator for the data export and number of decimal places to be 
displayed for different variables. 

Measurement Sensitivity 

Set the basic sensitivity for optical measurements. 

Meas. rep. color comp.  

Enter the measurement repetitions for recording the color compensation. 

Show negative values resulting from color compensation 

If activated, negative values are also displayed in the sequence of the color 
compensation, otherwise the output is “0”. 

Analysis You can enter a factor for the quantitative evaluations (Quant factor), for the melting curve 

analysis (Melting factor) and for the genotyping (Genotyping factor) in the list fields. This 

factor will be used for the automatic calculation of the threshold. 

 

Device Enables you to define a file name into which the device communication data will be 

written. The recorded data is used for error diagnosis (see section “Appendix B: How to 

Save Communication Data“, page 167). 

With the Select device function, the QIAquant 96 Software can be switched over to other 

real-time PCR devices offered by QIAGEN, without the appropriate device being 

connected. Projects that were created with this device can thus be analyzed on a different 

PC than that used for measurement. If a device is connected via USB and turned on when 

starting the program, it is automatically selected. 

 

User management Activate or deactivate the user management. 

If the user management is deactivated, no login prompt will appear at the program start. 

The functions for setting up the user management and for signing projects will not be 

available. 

 

Colors  Allows to select the color code of sample type and replicates and to let display the curves 

color according to sample type, well or replicates. 

The desired colors for wells, replicates, sample types and the marking of positive and 

negative analyses can also be set. 
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9 User management 

Note on the general data security 

Due to the encryption used, reading and changing project, template, evaluation and communication 

files generated by QIAquant 96 Software is only possible with the QIAquant 96 Software. 

The user management will be enabled in the window Options/User management. 

 

 

9.1 Basic settings for password, login and logout 

To access the basic settings that apply to all users, select the Extras > Options menu command. 
On the User management tab click on Settings. 

You can make the following settings in user management: 

 Option Description  

User login is required If enabled, the user management is effective at the next program start. Logging on to the 

program is then only possible with a valid user profile. 

Note: The first time the program is started after installation, an administrator with access 
to the user administration is created. 

Settings Settings for passwords, login and logout 

Edit Manage user profiles 

Option Description 
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 Number of login attempts: If the number of allowed login attempts to a user account is 

exceeded, i.e., if the attempts fail, the user account is deactivated. It can then only be 

reactivated by the administrator. 

 Minimum length of the user name and the password 

 Required characters in the password 

 Warning prior to the password expiring 

The password expiring is set in the user profiles 

 Logout in case of inactivity: After the specified time has expired without mouse or keyboard 

activity, the program interface will be locked and the login window is displayed. The user first 

has to enter the password before the interface can be used again. If Cancel is selected in the 

login window, the program is closed. It is not possible to change the user at this point. 

Automatic logout does not occur if a qPCR run is active. 
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9.2 Managing user profiles/user groups 

To access user management, select the Extras > Options menu command. On the User 
management tab click on Edit. 

 

The following functions are available in the extended user management: 

By default, these functions are only available to users belonging to the Administrator group. 

However, they can also be assigned to a Supervisor by editing the user rights. 

Add/edit user profile 

 To create a new user profile, click on Add. 

 To edit an existing user profile, mark the user profile in the list and click on Edit. 

 The window for editing the user profile appears. 

 Enter the following data: 

 Function Description  

Add Create a new user profile 

Edit Edit a selected user profile 

Delete Delete a selected user profile 
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Settings for the user name and the assigned user group 

 Option Description  
General tab  

User name Login name at program start 

Full name Actual name (optional) 

Description Further description (optional)  

User group Assign a user group 
The rights of each individual user can be individually adjusted within the user group 
(see below). 

 

Password tab   

Password Enter the password  

Confirm the password Repeat the password  

User must change password 
with new login 

If activated, users must change their password at first login.  

User may change password Users are allowed to change their own password.  

No password timeout The password is valid without a time limit.  
If deactivated, the expiry date must be specified. 

 

User is deactivated The user profile was automatically locked after multiple failed login attempts or by an 
authorized user. Enter the number of possible login attempts in the settings (see section 
“Basic settings for password, login and logout“, page 147). The time when the user 
was locked is displayed. 

 

User is locked The user profile has been locked by an authorized user. The user name no longer 
appears in the login dialog, however, the user remains created. The time when the 
user was deactivated is displayed. 

 

User can sign electronically The user is allowed to sign a project electronically (see section “Digital signatures“, 

page 157). 
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Settings for the password and the validity of the user profile 

User groups 

The following user groups are available: 

Administrator: 

 This user group has unlimited rights to all program functions 

 Administrators can create, delete, lock and unlock users and assign rights to them 

 They are allowed to change their own password and that of other users 

 They can deactivate user management in Extras > Options > User management 
 
Supervisor: 

 This user group has the same rights as the administrator, but administrators can block certain 

rights for each user logged in as a supervisor 

Operator: 

The following rights cannot be assigned to an operator: 

 Create and manage users 

 Create and save templates 

 Save projects 

 Changes in the Options window on the General, Thermal cycler, Scan, and Layout tabs 

With this selection you automatically assign a certain user role to the user and thus preset rights 

which you can additionally supplement or reduce using the Edit user access function. This allows 
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individual rights to be defined for each user. It is also possible to set up several administrators with 

different rights. 

 In the User profile/General window, click on Edit user group access. 

 The window of the same name containing the rights of the selected user appears. 

 If a checkbox is activated by a checkmark, this right is granted to the user and the user can 

use the function.  

 Checkboxes with a lock symbol cannot be changed.  

 The number of these locked rights is determined by the selected Administrator, Supervisor or 

Operator user role and increases in this order. This means that an operator has fewer rights 

than a supervisor or administrator from the outset and can never be assigned all rights.  

 An administrator has all rights in the program and these rights can only be restricted by 

removing the checkmarks. The right of an administrator to manage and create users cannot be 

locked, otherwise user management would no longer be possible. 
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9.3 Edit password 

If the user may change his password, he can open his user profile in the user management and 

change the password. Supervisors and operators can only do this in the usermanagement. They 

have not access to over functions in the usermangement. 

4. Open with the menu point Extras > Options the window Options/User management. 

5. Open with Edit the window User profiles. 

6. Select your user profile and click on Edit. 

7. Change and confirm the password in the window User profile/password. 

8. Confirm the settings and exit all windows with OK. 
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10 21 CFR Part 11 module 

QIAquant 96 Software contains functions that make the program compatible with the requirements 

of 21 CFR Part 11. The following functions are available: 

 Audit Trail in templates and projects, i.e., changes made to the project settings are 

continuously recorded. 

 Login Monitoring during which attempts to log in to the program and also changes to the user 

settings are stored 

 Editors for the evaluation of audit trails and log files using search functions, including a print 

function 

 Creation and display of Digital Signatures in templates and projects with monitoring of their 

validity 

 Automatic Logout in case of inactivity with the option of adjusting the time 

Note on data protection 

The created RTO-file contains the name of the computer on which activation should take place and 

the MAC address of the network card in encrypted form. QIAGEN uses this data in order to 

automatically generate the activation code for your computer. The data is processed in encrypted 

form. It is not used for other purposes or passed on to third parties. 

Manual activation 

If you are not allowed to copy or send files on your computer, a manual activation method is 

available. In this case, contact your contact person or dealer.  

10.1 Audit trail 

The audit trail records changes to metadata in templates and projects. Metadata determines how 

the results are calculated and displayed from the raw data of a qPCR run, and thus influences the 

result of the experiment. The raw data, on the other hand, always remains unchanged, meaning it 

is not part of the audit trail. If settings are changed in the project or the template, the new metadata 

is appended as a block to the original data when the file is saved. This process takes place 

automatically in the background. If a project is frequently opened and edited, the scope of the audit 

trail can increase considerably. It is not possible to delete contents in the audit trail. 
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Display and evaluate audit trail 

Search functions are available for evaluating the (in some cases extensive) audit trail of a project 

or a template. These functions allow you to systematically search for and identify changes to 

metadata. 

 Select the Compliance > Show audit trail menu command. 

 To start the search, click on Search. 

 To print out the content that is displayed in the text field (the complete audit trail or reduced 

content as a result of a search), click on Print. 

The following search options are available: 

 The Find info and Find text input fields are empty: The entire audit trail is displayed. 

 There is an entry in the Find info field: Search in the block headers, i.e., in the text in the 

square brackets. This makes it possible to track when the file was created, by whom, and how 

often it was edited. 

 There is an entry in the Find text field: Search in the audit trail. A search can be carried out 

for terms that characterize certain settings for the qPCR run, the display of results, the 

evaluations, the layout and general information. An overview of the terms and their meaning 

can be found in Appendix D. 

The input fields save search terms that have been previously used and make them available for 

reuse via the drop-down menu 
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10.2 Login monitoring 

All login processes in the QIAquant 96 Software are monitored and stored in encrypted form in a 

log file that is protected against manipulation by a checksum. This file also contains information 

about newly created users and digital signatures. The program records whether logins and 

signatures were successful or failed. In case of failed operations, the cause is also indicated (wrong 

password, wrong user name). 

 Select the Compliance > show log file menu command. 

 Limit the display by activating the checkboxes and the selection in the corresponding lists. 

 To print the displayed results, click on Print. 



 

 
 

QIAquant™ 96 Software User Manual   07/2021 157 

 

10.3 Digital signatures 

10.3.1 Signing a document 

Registered users who also have the relevant authorization can digitally sign a template or a project 

(see section “Managing user profiles/user groups“, page 149). The signature is equivalent to a 

handwritten signature because it can be clearly traced back to its creator. 

Sign an active document 

 Select the Compliance > Sign digitally menu command. 

 The Signature window appears. 

 Make the following settings: 
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 Confirm your entries with OK. 

 The digital signature is saved in the project or the template. Digital signatures are valid as 

long as no changes are made to the project or the template. 

 

10.3.2 Displaying signatures 

You can view and print out the signatures assigned to a project or a template. 

 Select the Compliance > Show signatures menu command. 

 The Show signatures window appears. You can check the validity of the date and the 

creator of the signature. 

 To print the displayed data, click on Print. 

 Parameter Description  

User name Select the registered users who are authorized to sign 

The user logged in to the program is preset in the selection 

Password Enter the user's password 

Status Select the signing status: Created, Edited, and Released 

Comment Additional explanation of the signature (optional) 
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Appendix A: Short Instruction 

The QIAquant 96 Software main window 

 

The main window is arranged in different areas: Menu bar (1), Toolbar (2), Project explorer (3), 

Project interface (4). 

Project window: Settings 

1. To create a new project select the menu command File > New or press the button  in the 

toolbar.  

Use the commands File >Open project or File >Open template to load saved files.  
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2. Open the Settings tab. 

 

3. Enter general information for the project under tab General. 

4. Enter PCR program under tab Thermal Cycler. 
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 Set lid temperature and activate or deactivate preheat mode. 

 Set temperature and time for each step. If desired define gradient. 

 For loops set the step number in column goto the program jumps back to and in the 

column loops define the number of measurement repeats. 

 If necessary define temperature or time increments or adjust the ramping rates. 

 If necessary activate the melting step and edit parameters. 

 In the column scan define at which step the fluorescence is measured. 

5. Define the fluorescence measurement settings on the tab Scan: 

 

 Set hash key in the column Measurement for each channel to measure 

 Select dye to measure in column Dye and set LED intensity in column Gain. 

 For passive reference check mark in column Pass. Ref. 

 Set number of measurement repeats and define region to scan. 

 If necessary activate color compensation. 

6. Define plate layout under the tab Samples (can be done during the run): 

 Set sample name and sample type. 

 Enter name for the gene to be measured in column Gene. 

 For standards enter concentration in column Conc. and set unit 

 Select position or region in the plate layout. 

 Assign settings to the selected wells using Toolbar button . 
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7. If the plate contains samples from different experiments that have to be analyzed separately 

create groups: 

 

 Select group and set group name. 

 Select position or region in the plate layout. 

 Assign settings to the selected wells using Toolbar button . 

8. The layout preview functions provide a comprehensive overview for the plate layout. To 

activate the layout preview use button . 

Project window: Monitoring 

 Press button  to start the run 

 In the Monitoring window the results of the run are displayed in real-time 
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 For the results either the PCR accumulation curves or the melting curves can be displayed. Use 

selective list View to display the different results. 

 Use dye tabs to select between the different dyes. 

 The PCR protocol can be displayed tabular, graphical or as temperature profile. 

 After the PCR run, Ct values and melting temperatures can be calculated for all samples 

without applying an evaluation. Click the Calculate Ct button in the amplification curve display 

or Calculate Tm in the melting curve display. 

Project window: Analysis 

For analysis different analysis methods for absolute quantification, relative quantification, ΔΔCt-

method, genotyping and melting curve analysis are available. 

 To start an analysis select corresponding tab and press button Add analysis in the toolbar. 

This button is labeled with a + symbol (for example, ). 

 In the window that opens enter a name for the analysis: 
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The analysis window is separated in a header for general settings, a graphical chart to display 

amplification curves and an area to display standard- or validation curves or the result table: 

 

In the header various settings can be made that differ by the analysis methods: 

 Select gene of interest (GOI). 

 If applicable set passive reference (e.g., ROX) for normalization. 

 Select between different experiments (groups). 

 Select at least one reference gene to calculate a standard or validation curve. 

 Set baseline correction. 
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 Set threshold (manually or automatically). 

 Switch between linear and logarithmic display of the fluorescence intensities. 

 

 In the amplification curves area the fluorescence intensity curves are shown: 

 In the linear mode the base line correction can be checked. 

 In the logarithmic mode the threshold line can be set manually. Move the threshold line up or 

down by using the mouse. 

 Switch by the tabs between the different dyes. 

 If the cursor is moved on a curve some short information for the sample is displayed. 

In the lower part of the analysis window the standard or validation curves are displayed: 

 For the curves calculated values are displayed in a table. 

 Use tabs to switch between the display of curves and of the result table. 

Standard-/Validation curves Results table 

  

 
 Define columns to be displayed in the result table after right mouse click on a column header. 

 Export data from the result table as CSV files after right mouse click in the table. 
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Appendix B: How to Save Communication Data 

With problems with your device you can record the communication data of the device and send it 

to the service. This makes easier the distant diagnosis. For this purpose the recording must be 

activated and a file name to the memory of the data be agreed. 

Note: To the activation of the recording of the data traffic you must be announced as an 
administrator. 

1. Run QIAquant 96 Software. 

2. Choose the menu command Extras > Options and open the Device tab. 

 

3. Activate the checkbox Save data traffic. 

4. Click the button […], the Open dialog appears. 

5. Type in a file name to which the communication data shall be sent. The extension of the 

traffic file is DTF. 

6. Confirm the dialog by clicking Open. 
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During the next PCR run the communication data between instrument and PC are recorded in the 

file denoted. Send this file to QIAGEN upon request. 
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Appendix C: Creating a Project Template from the 
Transfer File (LIMS) 

The QIAquant 96 Software can be configured by another program (e.g., a Laboratory Information 

Management System” (LIMS)). In order to do this, the LIMS has to create a file that is imported by 

QIAquant 96 Software via the File > Import LIMS function. The so-called transfer file has a specific 

structure that can be provided by QIAGEN if required QIAquant 96 Software creates a template 

with the transfer file, with which a PCR run can be started immediately. 

The different export functions of QIAquant 96 Software can be used to transfer the results of the 

PCR run to the LIMS, depending on which data the LIMS expects. 
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Appendix D: Entries in the Audit Trail 

 Audit-Trail print out Description  

      

[Administrator - 25.06.2018 08:47:00 - 
AT_DATA_CREATECLASS] 

Who created this project and when? Default Audit Trail 
data set is following. 

[Administrator - 04.07.2018 11:10:17 - 
AT_DATA_SAVEPROJECT] 

Who saved this project and when? Altered Audit Trail 
data set is following. 

General    

DEVICETYPE device type: 3=QIAquant 96   

APPVERSION version of QIAquant 96 Software used  

FIRMWAREVERSION firmware version of the connected device  

DataUser.Name -> Administrator logged in user  

DataUser.Level general user role (Administrator, Supervisor, Operator)  

DataUser.LevelBits granted rights of this user, coded in bits  

DataUser.Password password of the logged in user (not displayed here)  

DataUser.Userdependent not used  

General.Title title entered on the card General  

General.Operator operator  

General.DateTime date and time of project creation  

General.Comments comments entered on the card General  

General.DeviceID device identification data read from EEPROM  

Thermal Cycler    
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 Audit-Trail print out Description  

CyclerProgram -> 

ProgData.BlockType=14;ProgData.LidTemp=100;ProgData

.HotStart=True; 

ProgData.Control=10;ProgData.Standby=False;ProgData.

BlockTemp=12;ProgData.MeasTime=10;MeltData.StartTe

mp=60; 

MeltData.EndTemp=95;MeltData.Gradient=1;MeltData.Ti

me=16.128;MeltData.Ramp=5; 

MeltData.Equilibration=6;MeltData.Active=False;StepCoun

t=4;Head.ProgramNumber=1; 

Head.Gradient=False;Head.ProgramPath=TOP;Head.Prog

ramName=PCR;Head.ProgramDate.Day=11; 

Head.ProgramDate.Month=7;Head.ProgramDate.Year=12

;Step1.ScanFalse;Step1.Temp=95; 

Step1.Time=02:00;Step1.Goto=-;Step1.Loops=-

;Step1.TempInc=-;Step1.TimeInc=-

;Step1.Ramp=5;Step2.ScanFalse; 

Step2.Temp=95;Step2.Time=00:05;Step2.Goto=-

;Step2.Loops=-;Step2.TempInc=-;Step2.TimeInc=-; 

Step2.Ramp=5;Step3.ScanFalse;Step3.Temp=58;Step3.Ti

me=00:05;Step3.Goto=-;Step3.Loops=-; 

Step3.TempInc=-;Step3.TimeInc=-

;Step3.Ramp=5;Step4.ScanTrue;Step4.Temp=72;Step4.Ti

me=00:15; 

Step4.Goto=2;Step4.Loops=40;Step4.TempInc=-
;Step4.TimeInc=-;Step4.Ramp=5; 

program of the thermal cycler used fo this experiment  

Fluorescence Measurement    

ColorModule.Position -> 1 color module position 1  

ColorModule.Code -> Blue.455.515.11.3 type of the color module used  

ColorModule.Color -> FAM dye selected  

ColorModule.Gain -> 5 set gain  

ColorModule.Meas -> -1 activated for measurement (-1) or not (0)  

ColorModule.Refr -> 0 used as passive reference, Yes (-1), No (0)  

ColorModule.Position -> 2 color module position 2  

ColorModule.Code -> Green.520.560.11.2 type of the color module used  

ColorModule.Color -> JOE dye selected  

ColorModule.Gain -> 5 set gain  

ColorModule.Meas -> 0 activated for measurement (-1) or not (0)  

ColorModule.Refr -> 0 used as passive reference, Yes (-1), No (0)  
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 Audit-Trail print out Description  

ColorModule.Position -> 3 color module position 3  

ColorModule.Code -> Orange.580.620.11.2 type of the color module used  

ColorModule.Color -> ROX dye selected  

ColorModule.Gain -> 5 set gain  

ColorModule.Meas -> 0 activated for measurement (-1) or not (0)  

ColorModule.Refr -> 0 used as passive reference, Yes (-1), No (0)  

ColorModule.Position -> 4 color module position 4  

ColorModule.Code -> Red.633.680.11.1 type of the color module used  

ColorModule.Color -> Cy5 dye selected  

ColorModule.Gain -> 5 set gain  

ColorModule.Meas -> 0 activated for measurement (-1) or not (0)  

ColorModule.Refr -> 0 used as passive reference, Yes (-1), No (0)  

ColorModule.Position -> 5 color module position 5  

ColorModule.Code -> NIR1.660.710.11.1 type of the color module used  

ColorModule.Color -> Cy5.5 dye selected  

ColorModule.Gain -> 5 set gain  

ColorModule.Meas -> 0 activated for measurement (-1) or not (0)  

ColorModule.Refr -> 0 used as passive reference, Yes (-1), No (0)  

Compensation.Name ->  name of the color compensation used  

Compensation.Infos[0].Position through 
Compensation.Infos[5].Position 

information about color modules, dyes and gains used for 
this color compensation, displayed for all 6 color module 
positions 

 

Compensation.Infos[0].Color through 
Compensation.Infos[5].Color 

  
 

Compensation.Infos[0].Gain through 
Compensation.Infos[5].Gain 

color module the following gene is measured with 
 

Compensation.Matrix[0, 0] through 
Compensation.Matrix[5,5] 

elements of the color compensation matrix  

Scan.Repetitions -> 3 number of measurement repeats  

Scan.SpectralCompensation -> 0 type of the color compensation (off, standard, select)  

Scan.FromCol -> 1 begin of the scanned area of the plate  

Scan.ToCol -> 12 end of the scanned area of the plate  

Scan.ColRangeType -> 1 select scanned area from layout (-1) or manually (0)  

Layout    

Layout.Code -> Blue.470.520.11.3 color module the following gene is measured with  

Layout.Infos[A1].Gene  through Layout.Infos[H12].Gene gene name of each well of the plate  

Layout.Infos[A1].Concentration through 
Layout.Infos[H12].Concentration 

standard concentration of each well of the plate  

Units -> ng concentration unit  

Samples[A1].Name through Samples[H12].Name sample name for all wells  
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 Audit-Trail print out Description  

Samples[A1].Typ through Samples[H12].Typ sample type for all wells  

Samples[A1].SubTyp through Samples[H12].SubTyp  sample sub type for all wells  

Samples[A1].Comment through Samples[H12].Comment comments for each well  

Samples[A1].Active through Samples[H12].Active Is this well activated?  

Samples[A1].Marked through Samples[H12].Marked Is this well marked in the explorer?  

Groups[A1] -> 0 through Groups[H12] To which group does the well belong?  

GroupNames -> Group 1 through GroupNames -> Group 
12 

names of the 12 groups possible  

LOCK -> 0 template locked? Yes (-1), No (0)  

Calculate Ct    

CtAnalysis.Thresholds -> 0,794712458619839 threshold value  the Ct values were calculated with  

CtAnalysis.Smooth -> -1 smoothing On(-1), Off(0)  

CtAnalysis.SmoothMode -> 5 number of points used for smoothing  

CtAnalysis.Log -> 0 logarithmic chart On(-1), Off(0)  

CtAnalysis.BaseLineRange[0].Min -> 3 manually set lower boundary of the base line (cycle 
number) 

 

CtAnalysis.BaseLineRange[0].Max -> 15 manually set upper boundary of the base line (cycle 
number) 

 

CtAnalysis.BaseLineRange[1].Min -> 5 automatically set lower boundary of the base line (cycle 
number) 

 

CtAnalysis.BaseLineRange[1].Max -> -1 calculate automatically upper boundary of the base line 
range Yes (-1), No (0) 

 

CtAnalysis.AutoBaseLine -> -1 automatic base line determination On (-1) or Off (0)  

CtAnalysis.AutoThreshold -> 0 auto threshold On(-1), Off(0)  

CtAnalysis.Filter -> -1 filter On(-1), Off(0)  

CtAnalysis.FilterOptions -> 2 filter strength slight(0), medium(1) or strong(2)  

CtAnalysis.FilterSmooth -> 0 smooth the filter data, Yes (-1), No (0)  

Calculate Tm    

TmAnalysis.GOI.Color ->  melting curve GOI  

TmAnalysis.GOI.Gene ->  melting curve of gene  

TmAnalysis.Threshold -> 0 threshold value for determination of melting temperature  

TmAnalysis.Smooth -> -1 smooth melting curve , Yes (-1), No (0)  

TmAnalysis.SmoothMode -> 3 number of points used for smoothing  

TmAnalysis.Log -> 0 logarithmic chart On(-1), Off(0)  

TmAnalysis.BaseLineRange.Min -> 1 manually set lower boundary of the base line (cycle 
number) 

 

TmAnalysis.BaseLineRange.Max -> 5 manually set upper boundary of the base line (cycle 
number) 

 

TmAnalysis.AutoThreshold -> 0 auto threshold for melting curve, Yes (-1), No (0)  

TmAnalysis.FlipCurve -> 0 flip curve horizontally, On(-1), Off(0)  
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 Audit-Trail print out Description  

TmAnalysis.Scaling -> 1 All curves start at 100%(0), Maximum initial fluorescence 
= 100%(1) 

 

Absolute Quantification    

AbsQuantAnalyzes.Smooth -> -1 smoothing On(-1), Off(0)  

AbsQuantAnalyzes.SmoothMode -> 5 number of points used for smoothing  

AbsQuantAnalyzes.Log -> 0 logarithmic chart On(-1), Off(0)  

AbsQuantAnalyzes.BaseLineRange[0].Min -> 3 manually set lower boundary of the base line (cycle 
number) 

 

AbsQuantAnalyzes.BaseLineRange[0].Max -> 15 manually set upper boundary of the base line (cycle 
number) 

 

AbsQuantAnalyzes.BaseLineRange[1].Min -> 5 automatically set lower boundary of the base line (cycle 
number) 

 

AbsQuantAnalyzes.BaseLineRange[1].Max -> -1 calculate automatically upper boundary of the base line 
range Yes (-1), No (0) 

 

AbsQuantAnalyzes.AutoBaseLine -> -1 automatic base line determination On (-1) or Off (0)  

AbsQuantAnalyzes.AutoThreshold -> 0 auto threshold On(-1), Off(0)  

AbsQuantAnalyzes.Filter -> -1 filter On(-1), Off(0)  

AbsQuantAnalyzes.FilterOptions -> 1 filter strength slight(0), medium(1) or strong(2)  

AbsQuantAnalyzes.FilterSmooth -> 0 smooth the filter data, Yes (-1), No (0)  

AbsQuantAnalysis.Description -> Quantitation 1 title of this analysis  

AbsQuantAnalysis.Group -> 0 valid for group  

AbsQuantAnalysis.REF -> 0 passive reference used? Yes (-1), No (0)  

AbsQuantAnalysis.GOI.Color -> FAM dye of GOI  

AbsQuantAnalysis.GOI.Gene ->  name of GOI  

AbsQuantAnalysis.Threshold -> 1,13570592788773 threshold value  the Ct values were calculated with  

AbsQuantAnalysis.FitData.Count -> 4 number of standards  

AbsQuantAnalysis.FitData.M -> -3,67716352286466 slope of the standard curve  

AbsQuantAnalysis.FitData.N -> 28,0638862770259 intercept of the standard curve  

AbsQuantAnalysis.FitData.R2 -> 0,999236478923372 correlation coefficient of the linear curve fit  

AbsQuantAnalysis.FitData.Extern -> 0 Was the standard curve imported, Yes (-1), No (0)  

MIQE.TypeInfo -> 1 MIQE documentation for DNA(0) or RNA(1)  

LOCK -> 0 template or project locked? Yes (-1), No (0)  

Relative Quantification    

RelQuantAnalyzes.GOISmooth -> -1 smoothing GOI, On(-1), Off(0)  

RelQuantAnalyzes.GOISmoothMode -> 5 number of points used for smoothing, GOI  

RelQuantAnalyzes.GOILog -> 0 logarithmic chart GOI On(-1), Off(0)  

RelQuantAnalyzes.GOIBaseLineRange[0].Min -> 3 manually set lower boundary of the base line (cycle 
number GOI) 

 

RelQuantAnalyzes.GOIBaseLineRange[0].Max -> 15 manually set upper boundary of the base line  (cycle 
number GOI) 

 

RelQuantAnalyzes.GOIBaseLineRange[1].Min -> 5 automatically set lower boundary of the base line (cycle 
number GOI) 
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 Audit-Trail print out Description  

RelQuantAnalyzes.GOIBaseLineRange[1].Max -> -1 calculate automatically upper boundary of the base line 
range Yes (-1), No (0) 

 

RelQuantAnalyzes.GOIAutoBaseLine -> -1 automatic base line determination On (-1) or Off (0)  

RelQuantAnalyzes.GORSmooth -> -1 smoothing reference gene, On(-1), Off(0)  

RelQuantAnalyzes.GORSmoothMode -> 5 number of points used for smoothing of reference gene  

RelQuantAnalyzes.GORLog -> 0 logarithmic chart GOI On(-1), Off(0), reference gene  

RelQuantAnalyzes.GORBaseLineRange[0].Min -> 3 manually set lower boundary of the base line (cycle 
number reference gene) 

 

RelQuantAnalyzes.GORBaseLineRange[0].Max -> 15 manually set upper boundary of the base line  (cycle 
number reference gene) 

 

RelQuantAnalyzes.GORBaseLineRange[1].Min -> 5 automatically set lower boundary of the base line (cycle 
number reference gene) 

 

RelQuantAnalyzes.GORBaseLineRange[1].Max -> -1 automatically set upper boundary of the base line  (cycle 
number reference gene) 

 

RelQuantAnalyzes.GORAutoBaseLine -> -1 automatic base line determination On (-1) or Off (0), 
reference gene 

 

RelQuantAnalyzes.GOIAutoThreshold -> 0 auto threshold On(-1), Off(0), GOI  

RelQuantAnalyzes.GORAutoThreshold -> 0 auto threshold On(-1), Off(0), Reference gene  

RelQuantAnalyzes.GOIFilter -> -1 filter On(-1), Off(0), GOI  

RelQuantAnalyzes.GOIFilterOptions -> 1 filter strength GOI, slight(0), medium(1) or strong(2)  

RelQuantAnalyzes.GOIFilterSmooth -> 0 smooth the filter data GOI, Yes (-1), No (0)  

RelQuantAnalyzes.GORFilter -> -1 filter On(-1), Off(0), reference gene  

RelQuantAnalyzes.GORFilterOptions -> 1 filter strength reference gene,  slight(0), medium(1) or 
strong(2) 

 

RelQuantAnalyzes.GORFilterSmooth -> 0 smooth the filter data of reference gene, Yes (-1), No (0)  

RelQuantAnalysis.Description -> RelQ title of this analysis  

RelQuantAnalysis.Group -> 0 valid for group  

RelQuantAnalysis.REF -> 0 passive reference used? Yes (-1), No (0)  

RelQuantAnalysis.GOI.Color -> FAM dye of GOI  

RelQuantAnalysis.GOI.Gene ->  name of GOI  

RelQuantAnalysis.GOIThreshold -> 0,794712458619839 threshold value  the Ct values of the GOI were calculated 
with 

 

RelQuantAnalysis.GOR.Color ->  dye of reference gene  

RelQuantAnalysis.GOR.Gene ->  name of the reference gene  

RelQuantAnalysis.GORThreshold -> 50 threshold value  the Ct values of the reference gene were 
calculated with 

 

RelQuantAnalysis.GOIFitData.Count -> 4 number of standards, GOI  

RelQuantAnalysis.GOIFitData.M -> -3,62354563433653 slope of the standard curve, GOI  

RelQuantAnalysis.GOIFitData.N -> 27,5354442047509 intercept of the standard curve, GOI  

RelQuantAnalysis.GOIFitData.R2 -> 
0,999100282770293 

correlation coefficient of the linear curve fit, GOI  

RelQuantAnalysis.GOIFitData.Extern -> 0 Was the standard curve for GOI imported, Yes (-1), No (0)  
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RelQuantAnalysis.GORFitData.Count -> 0 number of standards, reference gene  

RelQuantAnalysis.GORFitData.M -> 1 slope of the standard curve, reference gene  

RelQuantAnalysis.GORFitData.N -> 0 intercept of the standard curve, reference gene  

RelQuantAnalysis.GORFitData.R2 -> 0 correlation coefficient of the linear curve fit, reference gene  

RelQuantAnalysis.GORFitData.Extern -> 0 Was the standard curve for reference gene imported, Yes 
(-1), No (0) 

 

DeltaDeltaCt Analysis    

DeltaDeltaCtAnalyzes.GOISmooth -> -1 smoothing GOI, On(-1), Off(0)  

DeltaDeltaCtAnalyzes.GOISmoothMode -> 5 number of points used for smoothing, GOI  

DeltaDeltaCtAnalyzes.GOILog -> 0 logarithmic chart GOI On(-1), Off(0)  

DeltaDeltaCtAnalyzes.GOIBaseLineRange[0].Min -> 3 manually set lower boundary of the base line (cycle 
number GOI) 

 

DeltaDeltaCtAnalyzes.GOIBaseLineRange[0].Max -> 15 manually set upper boundary of the base line  (cycle 
number GOI) 

 

DeltaDeltaCtAnalyzes.GOIBaseLineRange[1].Min -> 5 automatically set lower boundary of the base line (cycle 
number GOI) 

 

DeltaDeltaCtAnalyzes.GOIBaseLineRange[1].Max -> -1 calculate automatically upper boundary of the base line 
range Yes (-1), No (0) 

 

DeltaDeltaCtAnalyzes.GOIAutoBaseLine -> -1 automatic base line determination On (-1) or Off (0)  

DeltaDeltaCtAnalyzes.GORSmooth -> -1 smoothing reference gene, On(-1), Off(0)  

DeltaDeltaCtAnalyzes.GORSmoothMode -> 5 number of points used for smoothing of reference gene  

DeltaDeltaCtAnalyzes.GORLog -> 0 logarithmic chart GOI On(-1), Off(0), reference gene  

DeltaDeltaCtAnalyzes.GORBaseLineRange[0].Min -> 3 manually set lower boundary of the base line (cycle 
number reference gene) 

 

DeltaDeltaCtAnalyzes.GORBaseLineRange[0].Max -> 15 manually set upper boundary of the base line  (cycle 
number reference gene) 

 

DeltaDeltaCtAnalyzes.GORBaseLineRange[1].Min -> 5 automatically set lower boundary of the base line (cycle 
number reference gene) 

 

DeltaDeltaCtAnalyzes.GORBaseLineRange[1].Max -> -1 automatically set upper boundary of the base line  (cycle 
number reference gene) 

 

DeltaDeltaCtAnalyzes.GORAutoBaseLine -> -1 automatic base line determination On (-1) or Off (0), 
reference gene 

 

DeltaDeltaCtAnalyzes.GOIAutoThreshold -> 0 auto threshold On(-1), Off(0), GOI  

DeltaDeltaCtAnalyzes.GORAutoThreshold -> 0 auto threshold On(-1), Off(0), Reference gene  

DeltaDeltaCtAnalyzes.GOIFilter -> -1 filter On(-1), Off(0), GOI  

DeltaDeltaCtAnalyzes.GOIFilterOptions -> 1 filter strength GOI, slight(0), medium(-1) or strong(2)  

DeltaDeltaCtAnalyzes.GOIFilterSmooth -> 0 smooth the filter data GOI, Yes (-1), No (0)  

DeltaDeltaCtAnalyzes.GORFilter -> -1 filter On(-1), Off(0), reference gene  

DeltaDeltaCtAnalyzes.GORFilterOptions -> 1 filter strength reference gene,  slight(0), medium(1) or 
strong(2) 

 

DeltaDeltaCtAnalyzes.GORFilterSmooth -> 0 smooth the filter data of reference gene, Yes (-1), No (0)  

DeltaDeltaCtAnalysis.Description -> ddCt title of this analysis  

DeltaDeltaCtAnalysis.Group -> 0 valid for group  
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DeltaDeltaCtAnalysis.GOI.Color -> FAM dye of GOI  

DeltaDeltaCtAnalysis.GOI.Gene ->  name of GOI  

DeltaDeltaCtAnalysis.GOIThreshold -> 
0,794712458619839 

threshold value  the Ct values of the GOI were calculated 
with 

 

DeltaDeltaCtAnalysis.GOR.Color ->  dye of reference gene  

DeltaDeltaCtAnalysis.GOR.Gene ->  name of the reference gene  

DeltaDeltaCtAnalysis.GORThreshold -> 50 threshold value  the Ct values of the reference gene were 
calculated with 

 

DeltaDeltaCtAnalysis.EfficiencyCalc -> 0 PCR efficiency calculation according to Livak (0) or Pfaffl 
(1) 

 

DeltaDeltaCtAnalysis.EfficiencyType -> 0 if Pfaffl: calculate efficiency from standards (0) or entered 
values (1) 

 

DeltaDeltaCtAnalysis.GOIEfficiency -> 1 PCR efficiency of the GOI  

DeltaDeltaCtAnalysis.GOREfficiency -> 1 PCR efficiency of the reference gene  

DeltaDeltaCtAnalysis.GOIFitData.Count -> 4 number of standards, GOI  

DeltaDeltaCtAnalysis.GOIFitData.M -> -
3,62354563433653 

slope of the standard curve, GOI  

DeltaDeltaCtAnalysis.GOIFitData.N -> 
27,5354442047509 

intercept of the standard curve, GOI  

DeltaDeltaCtAnalysis.GOIFitData.R2 -> 
0,999100282770293 

correlation coefficient of the linear curve fit, GOI  

DeltaDeltaCtAnalysis.GORFitData.Count -> 0 number of standards, reference gene  

DeltaDeltaCtAnalysis.GORFitData.M -> 1 slope of the standard curve, reference gene  

DeltaDeltaCtAnalysis.GORFitData.N -> 0 intercept of the standard curve, reference gene  

DeltaDeltaCtAnalysis.GORFitData.R2 -> 0 correlation coefficient of the linear curve fit, reference gene  

DeltaDeltaCtAnalysis.ValFitData.Count -> 0 number of standards used for validation  

DeltaDeltaCtAnalysis.ValFitData.M -> 1 slope of the validation curve  

DeltaDeltaCtAnalysis.ValFitData.N -> 0 intercept of the validation curve  

DeltaDeltaCtAnalysis.ValFitData.R2 -> 0 correlation coefficient of the linear curve fit, validation  

Melt Curve Analysis    

MeltCurveAnalyzes.Smooth -> -1 smoothing GOI, On(-1), Off(0)  

MeltCurveAnalyzes.SmoothMode -> 3 number of points used for smoothing  

MeltCurveAnalyzes.Log -> 0 logarithmic chart On(-1), Off(0)  

MeltCurveAnalyzes.BaseLineRange.Min -> 1 manually set lower boundary of the base line   

MeltCurveAnalyzes.BaseLineRange.Max -> 5 manually set upper boundary of the base line  

MeltCurveAnalyzes.AutoThreshold -> 0 auto threshold On(-1), Off(0), GOI  

MeltCurveAnalyzes.FlipCurve -> -1 flip curve horizontally, On(-1), Off(0)  

MeltCurveAnalyzes.Scaling -> 0 All curves start at 100%(0), Maximum initial fluorescence 
= 100%(1) 

 

MeltCurveAnalysis.Description -> melt title of this analysis  

MeltCurveAnalysis.Group -> 0 valid for group  

MeltCurveAnalysis.GOI.Color -> FAM dye of GOI  
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MeltCurveAnalysis.GOI.Gene ->  name of GOI  

MeltCurveAnalysis.Threshold -> 0 threshold value above which the melt temperatures are 
determined 

 

Genotyping    

GenoTypingAnalyzes.GOISmooth -> -1 smoothing GOI, On(-1), Off(0)  

GenoTypingAnalyzes.GOISmoothMode -> 5 number of points used for smoothing, GOI  

GenoTypingAnalyzes.GOILog -> 0 logarithmic chart GOI On(-1), Off(0)  

GenoTypingAnalyzes.GOIBaseLineRange[0].Min -> 3 manually set lower boundary of the base line (cycle 
number GOI) 

 

GenoTypingAnalyzes.GOIBaseLineRange[0].Max -> 15 manually set upper boundary of the base line  (cycle 
number GOI) 

 

GenoTypingAnalyzes.GOIBaseLineRange[1].Min -> 5 automatically set lower boundary of the base line (cycle 
number GOI) 

 

GenoTypingAnalyzes.GOIBaseLineRange[1].Max -> -1 automatically set upper boundary of the base line  (cycle 
number GOI) 

 

GenoTypingAnalyzes.GOIAutoBaseLine -> -1 automatic base line determination On (-1) or Off (0)  

GenoTypingAnalyzes.GORSmooth -> -1 smoothing reference gene, On(-1), Off(0)  

GenoTypingAnalyzes.GORSmoothMode -> 5 number of points used for smoothing of reference gene  

GenoTypingAnalyzes.GORLog -> 0 logarithmic chart GOI On(-1), Off(0), reference gene  

GenoTypingAnalyzes.GORBaseLineRange[0].Min -> 3 manually set lower boundary of the base line (cycle 
number reference gene) 

 

GenoTypingAnalyzes.GORBaseLineRange[0].Max -> 15 manually set upper boundary of the base line  (cycle 
number reference gene) 

 

GenoTypingAnalyzes.GORBaseLineRange[1].Min -> 5 automatically set lower boundary of the base line (cycle 
number reference gene) 

 

GenoTypingAnalyzes.GORBaseLineRange[1].Max -> -1 calculate automatically upper boundary of the base line 
range Yes (-1), No (0) 

 

GenoTypingAnalyzes.GORAutoBaseLine -> -1 automatic base line determination On (-1) or Off (0), 
reference gene 

 

GenoTypingAnalyzes.GOIAutoThreshold -> 0 auto threshold On(-1), Off(0), GOI  

GenoTypingAnalyzes.GORAutoThreshold -> 0 auto threshold On(-1), Off(0), Reference gene  

GenoTypingAnalyzes.GOIFilter -> -1 filter On(-1), Off(0), GOI  

GenoTypingAnalyzes.GOIFilterOptions -> 1 filter strength GOI, slight(0), medium(1) or strong(2)  

GenoTypingAnalyzes.GOIFilterSmooth -> 0 smooth the filter data GOI, Yes (-1), No (0)  

GenoTypingAnalyzes.GORFilter -> -1 filter On(-1), Off(0), reference gene  

GenoTypingAnalyzes.GORFilterOptions -> 1 filter strength reference gene,  slight(0), medium(1) or 
strong(2) 

 

GenoTypingAnalyzes.GORFilterSmooth -> 0 smooth the filter data of reference gene, Yes (-1), No (0)  

GenoTypingAnalyzes.SPType -> 1 genotyping based on Ct (1) or dRn (0)  

GenoTypingAnalyzes.EPLast -> -1 end point is the last cycle (1) or enter cycle manually  

GenoTypingAnalyzes.EPCycle -> -1 manually entered end point cycle  

GenoTypingAnalyzes.InfoText -> wild type text 1  

GenoTypingAnalyzes.InfoText -> mutant text 2  
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GenoTypingAnalyzes.InfoText -> heterozygote text 3  

GenoTypingAnalyzes.InfoText -> error text 4  

GenoTypingAnalysis.Description -> Geno title of this analysis  

GenoTypingAnalysis.Group -> 0 valid for group  

GenoTypingAnalysis.REF -> 0 passive reference used? Yes (-1), No (0)  

GenoTypingAnalysis.GOI.Color -> FAM dye of GOI  

GenoTypingAnalysis.GOI.Gene ->  name of GOI  

GenoTypingAnalysis.GOIThreshold -> 
0,794712458619839 

threshold value  the Ct values of the GOI were calculated 
with 

 

GenoTypingAnalysis.GOR.Color ->  dye of reference gene  

GenoTypingAnalysis.GOR.Gene ->  name of the reference gene  

GenoTypingAnalysis.GORThreshold -> 50 threshold value  the Ct values of the reference gene were 
calculated with 

 

GenoTypingAnalysis.SPCutOff0 -> 0 cut off value 1, Ct  

GenoTypingAnalysis.SPCutOff1 -> 0,794712458619839 cut off value 2, Ct  

GenoTypingAnalysis.EPCutOff0 -> 49 cut off value 1, Cycle  

GenoTypingAnalysis.EPCutOff1 -> 51 cut off value 2, cycle  

End Point Analysis    

EndPointAnalyzes.Smooth -> -1 smoothing GOI, On(-1), Off(0)  

EndPointAnalyzes.SmoothMode -> 5 number of points used for smoothing, GOI  

EndPointAnalyzes.Log -> 0 logarithmic chart GOI On(-1), Off(0)  

EndPointAnalyzes.BaseLineRange[0].Min -> 3 manually set lower boundary of the base line (cycle 
number GOI) 

 

EndPointAnalyzes.BaseLineRange[0].Max -> 15 manually set upper boundary of the base line  (cycle 
number GOI) 

 

EndPointAnalyzes.BaseLineRange[1].Min -> 5 automatically set lower boundary of the base line (cycle 
number GOI) 

 

EndPointAnalyzes.BaseLineRange[1].Max -> 25 automatically set upper boundary of the base line  (cycle 
number GOI) 

 

EndPointAnalyzes.AutoBaseLine -> -1 automatic base line determination On (-1) or Off (0)  

EndPointAnalysis.Description -> Endp title of this analysis  

EndPointAnalysis.Group -> 0 valid for group  

EndPointAnalysis.GOI.Color -> FAM dye of GOI  

EndPointAnalysis.GOI.Gene ->  name of GOI  

EndPointAnalysis.GOICutOff -> 2040,83542831301 cut off value of GOI  

EndPointAnalysis.IPC.Color ->  Dye of the internal positive control (IPC)  

EndPointAnalysis.IPC.Gene ->  gene name of the internal positive control  

EndPointAnalysis.IPCCutOff -> 0 cut off value of the internal positive control  

EndPointAnalysis.OptionCycles -> -1 end point analysis based on end point intensities, Yes (-1), 
No (0) 

 

EndPointAnalysis.OptionLastCycles -> 2 number of last cycles used for calculation  
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EndPointAnalysis.OptionFromCycle -> 38 start cycle end point range  

EndPointAnalysis.OptionToCycle -> 40 end cycle end point range  

EndPointAnalysis.OptionCutOff -> -1 end point analysis based on NTC intensities, Yes (-1), No 
(0) 

 

EndPointAnalysis.OptionCutOffNTC -> 10 factor applied to the NTC intensities for threshold 
calculation  

 

EndPointAnalysis.OptionCutOffNTC_IPC -> 2 confidence intervals: (0)95%, (1)99%, (2)99.5%, 
(3)99.7%, (4)99.9% 

 

EndPointAnalysis.OptionCutOffInput -> 0 use cut off values from table Yes(-1), No (0)  

MIQE.TypeInfo -> 1 MIQE documentation for DNA(0) or RNA(1)  

LOCK -> 0 template or project locked? Yes (-1), No (0)  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For up-to-date licensing information and product-specific disclaimers, see the respective QIAGEN 

kit handbook or user manual. QIAGEN kit handbooks and user manuals are available at 

www.qiagen.com or can be requested from QIAGEN Technical Services or your local distributor. 
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07/2021 Minor updates of the user manual due to the changes in the Software and the QIAquant 
instrument Hardware 

03/2020 Initial release 

 

Trademarks: QIAGEN®, Sample to Insight®, QIAquant™ (QIAGEN Group); Excel® (Microsoft Corporation). Registered names, trademarks, etc. used in this document, even when not specifically marked as such, are not to 
be considered unprotected by law.  

HB-2741-002 07/2021 1120414 © 2021 QIAGEN, all rights reserved. 



 

 
 

QIAquant™ 96 Software User Manual   07/2021 182 

 

1120414  HB-2741-002 07/2021   

Ordering www.qiagen.com/shop | Technical Support support.qiagen.com | Website www.qiagen.com 


	1 Introduction
	Described software version
	Supported devices
	File formats
	1.1 How to use this user manual
	1.1.1 Technical assistance
	1.1.2 Policy statement

	1.2 Installation of QIAquant 96 Software
	System requirements for installing QIAquant 96 Software
	Installation procedure
	Set up administrator

	1.3 Starting and exiting QIAquant 96 Software
	Starting QIAquant 96 Software
	Exiting QIAquant 96 Software

	1.4 The main window in QIAquant 96 Software
	1.4.1 Menu commands overview
	1.4.2 Overview of the tools in the toolbar
	1.4.3 Project explorer components
	Organization of the project explorer

	1.4.4 Project interface with project window
	1.4.5 Version number of the software

	1.5 Warranty and liability

	2 Managing projects and templates
	2.1 Creating a new project or opening a project
	Creating a new project
	Creating a new project based on a template
	Opening a saved project
	Opening an automatically saved project
	Viewing the projects

	2.2 Saving a template
	2.3 Saving a project
	2.4 Importing/exporting analyses
	2.5 Creating a project template from a transfer file
	2.6 Performing a Multigene-/Multiplate-Analysis
	2.7 Closing project windows
	2.8 Printing

	3 Settings for a Real-Time PCR experiment
	3.1 Entering general information on the project
	3.2 Creating a PCR protocol
	Editing a PCR protocol
	3.2.1  Entering information in the program header
	3.2.2 Overview about the PCR protocol
	3.2.3 Inserting a new temperature step/deleting a temperature step
	3.2.4 Entering the target temperature, hold time and heating/cooling rates
	3.2.5 Defining loops
	3.2.6 Entering increments/decrements for temperature and hold time
	3.2.7 Arranging a fluorescence measurement
	3.2.8 Adding a melting curve
	3.2.9 Programming the temperature gradient
	Temperature gradient with margin rows
	Programming a linear gradient

	3.2.10 Graphical display and programming the PCR protocols

	3.3 Defining the parameters for the fluorescence measurement
	3.3.1 Manually defining the scan region
	3.3.2 Color compensation
	Color compensation: Off
	Color compensation: Standard
	Color compensation: Selection
	Spectral calibration


	3.4 Editing the sample table
	3.4.1 Entering sample properties in the layout
	3.4.2 Entering sample properties into the sample table
	Selecting the table view
	Selecting curve colors
	Displaying sample properties in the project explorer

	3.4.3 Entering a sample layout for a multiplex assay
	Emptying sample layout
	Defining samples
	Defining the standard samples

	3.4.4 Entering a sample layout for a singleplex assay
	Emptying sample layout
	Defining samples
	Defining the standard samples

	3.4.5 Automatic generation of dilution series/replicates
	Creating a dilution series
	Creating replicates

	3.4.6 Defining groups
	3.4.7 Layout preview
	3.4.8 Copying the layout
	3.4.9 Exporting or importing the layout in Excel
	3.4.10 Functions for creating and editing a plate layout


	4 Monitoring
	4.1 Starting the PCR protocol
	4.2 Display options for monitoring
	4.2.1 Default settings for the Monitoring view
	4.2.2 Adjusting the view in the Monitoring project window
	4.2.3 Displaying and hiding measurement results for individual wells
	4.2.4 Exporting fluorescence data

	4.3 Monitoring the PCR run
	Table list sheet
	Graph list sheet
	T profile list sheet

	4.4 Displaying product accumulation curves and calculating Ct values
	Displaying the product accumulation curve
	Calculating the Ct values

	4.5 Displaying melting curves and calculating the melting temperatures Tm
	Displaying melting curves
	Calculating the melting temperature Tm


	5 Evaluation
	5.1 General functions in the evaluation project window
	5.1.1 Making basic settings
	5.1.2 Activating/deactivating samples for evaluation
	5.1.3 Exporting fluorescence data
	5.1.4 Configure results table
	5.1.5 Export results

	5.2 Absolute quantification
	5.2.1 Creating an evaluation for an absolute quantification
	5.2.2 Setting parameter for absolute quantification
	Setting the threshold value
	Fix Threshold

	5.2.3 Displaying the fluorescence curves for absolute quantification
	Switching the display options for the chart

	5.2.4 Display of the mean Ct values or mean concentrations
	5.2.5 Displaying the standard curve and results of an absolute quantification
	Display in the project explorer

	5.2.6 Exporting results of calculations
	Excel and CSV
	Export to qBASE+

	5.2.7 Importing the standard curve
	5.2.8 Deleting the evaluation of an absolute quantification

	5.3 Relative quantification
	5.3.1 Creating a new evaluation for a relative quantification
	5.3.2 Parameter settings for relative quantification
	Setting the threshold value
	Fix Threshold

	5.3.3 Displaying the fluorescence curves in the relative quantification
	Switching the display options for the chart

	5.3.4 Display of the normalized relative concentrations
	5.3.5 Displaying the standard curves and the results of a relative quantification
	Display in the project explorer

	5.3.6 Importing the standard curve for relative quantification
	5.3.7 Deleting the evaluation of a relative quantification

	5.4 ΔΔCt method
	5.4.1 Creating a new evaluation for a ΔΔCt method
	5.4.2 Parameter settings for the ΔΔCt method
	Setting the threshold value
	Fix Threshold

	5.4.3 Displaying the fluorescence curves for the ΔΔCt method
	Switching the display options for the chart

	5.4.4 Display of the normalized relative expression or relative quantities
	5.4.5 Setting the calculation mode for the standardized expression
	Calculating the standardized expression SE without efficiency calculation (Livak method)
	Calculating the standardized expression SE with efficiency calculation (Pfaffl method)

	5.4.6 Displaying the validation curves and values
	Display in the project explorer

	5.4.7 Deleting a ΔΔCt method evaluation

	5.5 Melting curve analysis
	5.5.1 Creating a new melting curve analysis
	5.5.2 Parameter settings for melting curve analysis
	Setting the threshold value
	Fix Threshold

	5.5.3 Displaying fluorescence curves/melting curves
	Switching the display options for the chart of fluorescence curves

	5.5.4 Display of melting temperatures
	5.5.5 Displaying the result table for the melting curves
	Display in the project explorer

	5.5.6 Deleting a melting curve analysis

	5.6 Genotyping
	5.6.1 Creating a new evaluation for genotyping
	5.6.2 Parameter settings for genotyping
	Setting the threshold value
	Fix Threshold

	5.6.3 Specifying genotyping options
	5.6.4 Displaying the fluorescence curves, scatter plot and bar graph
	5.6.5 Display of the values for the genotyping evaluation
	Display in the project explorer

	5.6.6 Deleting a genotyping

	5.7 POS/NEG analysis at the end point
	5.7.1 Starting end point analysis
	5.7.2 Parameters settings for endpoint analysis
	Setting Cutoff values

	5.7.3 Displaying results in end point analysis
	Without IPC
	With IPC
	Evaluation of replicates
	Results table
	PCR plate scheme (Grid)
	Bar Chart



	6 Multigene-/Multiplate-Analysis
	6.1 Start Multigene-/Multiplate-Analysis
	6.2 The window for Multigene-/Multiplate-Analysis
	6.3 Overview of menu commands
	6.4 Overview of the tools in the toolbar
	6.5 Managing Multigene-/Multiplate-Analysis files
	6.5.1 Start new Multigene-/Multiplate-Analysis
	6.5.2 Open saved Multigene-/Multiplate-Analysis
	6.5.3 Save Multigene-/Multiplate-Analysis
	6.5.4 Close Multigene-/Multiplate-Analysis
	6.5.5 Print Multigene-/Multiplate-Analysis

	6.6 Load Project Files
	6.7 Activate/Deactivate project files for Multigene-/Multiplate-Analysis
	6.8 Activate/Deactivate samples for Multigene-/Multiplate-Analysis
	6.9 Define Interplate-Standards for Multigene-/Multiplate-Analysis
	6.10 Set threshold and PCR-efficiencies for Multigene-/Multiplate-Analysis
	Edit threshold
	Edit PCR efficiency

	6.11 Evaluation of the Multigene-/Multiplate-Analysis
	Parameter settings for Multigene-/Multiplate-Analysis
	Results display for Multigene-/Multiplate-Analysis


	7 MIQE documentation
	Instructions for completing the MIQE documentation

	8 Functions in Extras menu
	8.1 Device initialization
	8.2 General settings in the QIAquant 96 Software

	9 User management
	Note on the general data security
	9.1 Basic settings for password, login and logout
	9.2 Managing user profiles/user groups
	Add/edit user profile
	User groups

	9.3 Edit password

	10 21 CFR Part 11 module
	Note on data protection
	Manual activation
	10.1 Audit trail
	Display and evaluate audit trail

	10.2 Login monitoring
	10.3 Digital signatures
	10.3.1 Signing a document
	Sign an active document

	10.3.2 Displaying signatures


	Appendix A: Short Instruction
	The QIAquant 96 Software main window
	Project window: Settings
	Project window: Monitoring
	Project window: Analysis

	Appendix B: How to Save Communication Data
	Appendix C: Creating a Project Template from the Transfer File (LIMS)
	Appendix D: Entries in the Audit Trail
	Document Revision History

